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1.0 Introduction

Welcome to Synaptive™Modus Plan™, advanced surgical planning software. Modus Plan provides real-
time 3D rendering of medical image scans such as MRIs, and provides tools for reviewing, manipulating
and annotating those images.

Modus Plan can be used in two modes: Plan and Investigate.

l Use Plan mode to create surgical plans based on diffusion data registered to anatomical structures.

l Use Investigate mode to review and annotate images, and to view an exported surgical plan created
in Plan mode.

NOTE: The graphics and medical images in this manual are examples only. The actual design and display
on your system may vary.

1.1 Product and Safety Symbols

Symbol Title Reference Description

Caution ISO 7000-
0434A

To indicate that caution is necessary when operating the device
or control close to where the symbol is placed, or to indicate that
the current situation needs operator awareness or operator
action in order to avoid undesirable consequences.

Manufacturer ISO 7000-
3082

To identify the manufacturer of a product.

Consult
instructions
for use

ISO 7000-
1641

To identify the location where the operator's manual is stored or
to identify information that relates to the operating instructions.
To indicate that the operating instructions should be considered
when operating the device or control close to where the symbol
is placed.

Catalog
number

ISO 7000-
2493

To identify the manufacturer's catalog number, for example on a
medical device or the corresponding packaging.

Serial number ISO 7000-
2498

To identify the manufacturer's serial number, for example on a
medical device or its packaging.

Table 1 ISO 7000 - Graphical symbols for use on equipment - Registered symbols and ISO 15223-1 - Med-
ical devices - Symbols to be used with medical device labels, labeling and information to be supplied
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Symbol Description

U.S. Federal law restricts this device to sale by or on the order of a licensed healthcare
provider.

Table 2 Other Symbols

1.2 Indications for Use
Modus Plan is indicated for:

l Viewing, presentation and documentation of medical imaging, including different modules for image
processing, image fusion, and image segmentation where the output can be used for image guided
surgery.

l Planning and simulation of cranial surgical procedures.

l Reviewing of existing treatment plans.

Typical users of the software are medical professionals, including but not limited to surgeons and
radiologists.

1.3 Contraindications
The Modus Plan software tool is not intended for final interpretation in Full-field Digital Mammography.

Modus Plan should not be used to create a surgical plan unless the data series has been reviewed by a
radiologist or surgeon.

The data review functionality of Modus Plan should be used to first review the data series by a radiologist
or surgeon prior to development of a surgical plan.

Modus Plan is not designed as a primary tool for disease detection or diagnosis.

Additional contraindications include scenarios where processing errors occur such as noisy scan data,
partial skull mask, incorrect skull mask, poor registration, or poor diagnostic image quality. Modus Plan
may not generate processed data series (e.g. tractography) for these scenarios. Modus Plan has input file
checks that warn the user or provide an error message for some of these contraindications.

1.4 Intended Use Environment
The Modus Plan system is intended for use in hospitals, clinics, and other medical institutions.

1.5 Important Information
Caution: Federal law restricts this device to sale by or on the order of a physician.
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1.5.1 Medical Professional Responsibilities
Modus Plan has been designed for use by trained, qualified, medical professionals. Decisions made by the
medical professional during planning should be based on sound clinical (e.g., anatomical) knowledge.

l Modus Plan does not choose or recommend any particular planned trajectory. It is the responsibility
of the medical professional to choose the most effective trajectory based on clinical knowledge.

l Modus Plan does not detect high-risk trajectories. It is the responsibility of the medical professional
to choose the most effective trajectory based on clinical knowledge.

l Manually adjusting the registration of tractography also affects ADC, FA and RGB registration. Use
caution during manual adjustment, as improving a local registration can have negative results
elsewhere in the volume.

1.5.2 Use Cautionwhen Interpreting Images
l Tract information displayed in Modus Plan is based on diffusion data; it does not necessarily
correspond to nerve bundles.

l The diffusion tract colors are based on the axes of the scanner. If the patient’s head is not aligned
with the scanner, the colors will not map to the patient axes.

l Image data received from the scanner may be oriented incorrectly (left and right may be reversed).
Always review the data labeling in Modus Plan before creating a surgical plan.

1.5.3 Risks Associatedwith Poor Image Quality or Missing Data
l Accepting poor quality series may impede location of appropriate surgical targets and regions of
interest.

l Accepting a series with missing slices may prevent you from locating appropriate surgical targets
and regions of interest. Before working with a series in a study retrieved from a DICOM server,
always review the entire series to ensure that all slices have been retrieved from the server.

l Image artifacts may distort anatomy and visualizations such as tractography. Use caution and
clinical judgment when planning on a series with distorted images.

l Using image data that does not cover the complete brain may prevent selection of the optimal
surgical plan.

l Accepting an image series with low resolution will impact the accuracy of the surgical plan.

l If you do not accept the diffusion data, youwill not be able to use tractography for trajectory
planning.

1.5.4 Risks Associatedwith Accepting Modus Plan Visualizations
l Accepting series with poor registration will lead to inaccuracy in plans and surgery.

l Accepting a brain mask that excludes part of the brain may result in a trajectory that originates
beneath the surface of the brain.

l Accepting a brain mask that includes part of the skull may result in diffusion tracts located outside of
the brain. Depth to target calculations may be incorrect and sulci may be occluded in certain phases
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of planning.

l The window/level settings may cause sulci to appear wider and deeper than they are.

1.5.5 Always Verify Patient Data andOrientation
l Using data from the wrong patient will lead to an incorrect surgical plan. Always verify that the
patient name and demographic data in the study are correct.

l Modus Plan permits two views: radiological and surgical. Misunderstanding the view you are using
could result in a surgical plan on the wrong side of the body. Always confirm the orientation of the
patient using the orientation labels when creating and editing a trajectory.

1.5.6 Image Storage and Retrieval
It is possible for errors to occur when images are transported across a network, or on import into the
Modus Plan local database. Never assume that these operations have completed successfully. Always
verify the success of the operation before working with the images in a study.

1.5.6.1 DICOM Query/Retrieve

Due to limitations in the DICOM format, when a study is sent to the Modus Plan workstation from another
DICOM device, the Modus Plan workstation is not able to determine whether or not it received all the
images in the study.

If youmanually initiate the retrieval of one or more imaging studies from another DICOM device to the
Modus Plan workstation, it is important to check the Activity Monitor for any errors that may occur during
the transport (for more information, see 8.1 Working in the Activity Monitor on page 93). For each study
retrieved, there will be one work item for the retrieve operation which, if successful, will indicate the
number of images retrieved along with the number expected; these numbers should be the same. There
will be a second work item for importing the received images into the local database. If both work items
completed successfully, and the number of expected, received, and imported images are all the same,
then the entire study was retrieve successfully. Note, however, that the number of expected images
comes from the remote DICOM device, over which the Modus Plan workstation has no control. If this
number is not provided accurately by the remote device, then the success of the retrieval cannot be
known.

You can use the Modus Plan workstation to retrieve individual series within a study, which will result in a
partial study in the local database possibly leading to an incorrect plan due to incomplete information. Use
this feature with care. If there is any doubt about the suitability of retrieving only part of a study, then
retrieve the entire study.

Studies opened for viewing before they have been completely retrieved remain incomplete; they are not
updated as new images are received or imported.

You are responsible for ensuring that all necessary images have been successfully retrieved and imported
into the local database before using a study to create a plan.

1.5.6.2 DICOM Send

When sending studies to another device, always verify that the entire study was sent successfully.
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Work items for studies being sent to a remote device can be canceled in the Activity Monitor. However,
the operation must either be restarted and allowed to complete successfully, or the study should be
manually deleted from the destination device. Canceling a send operation will result in a partial study on
the destination device, which, depending on how the study is being used, could lead to patient
misdiagnosis due to incomplete information.

Individual series in a study can also be sent to a remote DICOM device, which will result in a partial study
on the destination device. Use this feature with care. If there is any doubt about the suitability of sending
only part of a study, then send the entire study.

1.5.6.3 Importing Images into the Local Database

When importing images to the local database, always check the Activity Monitor to ensure that all the
number of images imported matches the expected number of images.

1.5.6.4 Deleting Studies and Series

If you delete a study from the local database, any planning workflow data associated with that study is
also deleted from the Modus Plan workstation. It will not be possible to resume that workflow (even if the
study is re-imported into the local database) unless Modus Plan is configured to synchronize with
ImageDrive Clinical.

Individual series can be deleted from studies in the local database. Use this feature with care as it can
result in a partial study, which could result in an inaccurate plan due to incomplete information.

1.5.7 Dedicated Installation
Do not install any other software on the Modus Plan workstation. Installing other software in the system
or modifying the hardware will invalidate the tests conducted by the manufacturer to prove that the
device is safe and effective.

1.5.8 Installation and Service
Only personnel approved by Synaptive Medical may install, alter, or otherwise provide service for the
Modus Plan software.

1.5.9 Data Backup
The plans created by Modus Plan should always be exported to a picture archiving and communication
system (PACS). Consequently, it is not necessary to back up the data on the Modus Plan workstation. To
improve performance, regularly delete studies that are no longer needed from the workstation file store.
For more information, see 2.4Working with Studies on page 18.
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1.6 Synaptive Customer Service Information
For 24-hour access to clinical and technical support, contact Synaptive customer service.

Phone: 1-844-462-7246 (North America)

1-647-925-3435 (International)

Email: service@synaptivemedical.com
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2.0 Getting Started

2.1 OpeningModus Plan and Logging In
To openModus Plan, double-click the Modus Plan icon on the desktop.

All users must log in to Modus Plan. Enter your password and click Login.

NOTE: Your Modus Plan password is the same as your Windows account password. If you do not know
your password, contact your IT administrator.

Figure 1 Modus Plan login dialog

You do not need to log out of Modus Plan. Youwill be automatically logged out when you close the
application.

2.2 About the Study Explorer
Modus Plan opens in the study explorer where you can locate and workwith studies.
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Figure 2 Study explorer interface

1 Explorer tab. If you are working with a study in Investigate mode, you can access the study explorer by clicking
the Explorer tab. In Plan mode, you must exit Plan mode to return to the study explorer.

2 The DICOM tab displays studies in the local database (My Studies) and any remote DICOM servers Modus Plan is
configured to communicate with, such as a PACS.

3 The My Computer tab displays an explorer view of the workstation. Use this tab to locate studies on the
workstation or to import studies from external media such as a flash drive.

4 The Servers pane lists the local database and the remote DICOM servers Modus Plan is configured to
communicate with. For more information about working with servers, see 8.3 Server Configuration on page 100.

5 The Studies pane displays the studies on the selected server.

6 Use the fields in the Search pane to locate studies on the selected server.

2.2.1 About the Local Database (My Studies)
The My Studies item in the Servers pane displays the studies in the local database. When you import a
study from a remote DICOM server or from an external media source such as a DVD or flash drive, the
study appears in the My Studies pane.

2.2.2 Searching for Studies
Use the Search pane to search for studies in the local database or on a DICOM server.
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Figure 3 Search pane

To search for studies:

1. In the Servers pane, select the location youwant to search in: either the local database (My Studies)
or a DICOM server.

2. Enter your search criteria, or click Today or Last 7 Days to search for studies with a study date of
today or within the last seven days.

You can enter partial values in the search criteria fields (for example only the first few letters of the
patient's name) or use the asterisk (*) wildcard to match multiple characters (for example, enter
'*stereotactic' in the Study Description field to find all studies whose description ends in
'stereotactic').

NOTE: The search criteria fields are not case sensitive.

3. Click Search. Studies matching your search criteria appear in the studies pane.

To view all the studies on the selected server, click Clear to empty the search criteria fields, then click
Search again.

2.2.3 Opening a Study
To open a study, select it and clickOpen in the studies pane toolbar (or double-click on the study). In the
Workflow Study Launcher dialog, click the mode youwant to open the study in.

Figure 4 Workflow Study Launcher dialog

For other options for working with studies, see 2.4Working with Studies on page 18.

NOTE: If you are opening a workflow created in a previous version of Modus Plan containing regions with
non-uniform slice spacing on the primary series, these regions will not be available. A message appears
when you open this study in the Planmode. Youmay continue opening the study but youmust create new
regions for the plan.

Page 15 of 124 MAN-0680 Revision B

Synaptive Modus Plan User Manual 2.2  About the Study Explorer



2.2.4 Using PlanSync
If Modus Plan is connected to Synaptive's ImageDrive Clinical system and you open a study, a dialog
appears giving you the option to select the session that youwant to work on.

To start working with a study:

1. Open a study from the study explorer.

2. In the Load Session dialog, select one of the options.

Figure 5 Load Session dialog

Start a new
local session

Starts a new plan workflow. If you select this option, the existing local session will be
overwritten.

Continue
local session

Resumes your previous plan workflow session.

If a previous session does not exist, this option is not available.

Load session
from
ImageDrive
Clinical

Loads a plan workflow from ImageDrive Clinical. If you select this option, the existing
local session will be overwritten.

Select the Show all users' sessions checkbox to display all sessions that other users
have uploaded to ImageDrive Clinical. Clear the checkbox to display only the most
recent sessions that you have uploaded to ImageDrive Clinical.

NOTE: It is recommended that you use the same user name to log into both Modus
Plan and ImageDrive Clinical. If you are using different user names, contact your
system administrator to synchronize your login account for both systems.

Select a session from the list. You can select a session created by other users and
rename it as a new session when you exit Modus Plan.

3. ClickOK.

The session that you have selected is loaded in Modus Plan.
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2.3 Adding a Study to the Local Database
If the study youwant to plan on is not already in the local database, there are two ways to add it.

l If the study exists on another DICOM server, you can retrieve it from that server. For more
information, see Retrieving Studies from a DICOM Server below.

l If you have the study on a CD, DVD, or USB flash drive, you can import it into the local database. For
more information, see 2.3.2 Importing from a CD, DVD, or USB Flash Drive on page 17.

When you add a study to the local database, Modus Plan automatically performs the processing
necessary to visualize the diffusion and tractography data in Plan mode. This processing starts 60
seconds after the study has been added (to ensure that all available data has been copied to the local
database) and appears in the Activity Monitor as “Process Study”. If the processing completes
successfully, the Activity Monitor displays the message “Neuro image processing completed successfully.”

NOTE: Processing may take up to 30 minutes to complete. 

2.3.1 Retrieving Studies from a DICOM Server
Only studies in the local database can be used to create a surgical plan in Plan mode. If the study youwant
to use is on a remote DICOM server, youmust retrieve it.

To retrieve a study from a DICOM server:

1. In the Servers pane on the Explorer tab, select the server youwant to retrieve from.

2. Select the study or studies youwant to import in the studies pane (use the search fields to locate
them if necessary).

NOTE: To select multiple studies hold down the SHIFT key or CTRL key when clicking in the studies
pane.

3. Click Retrieve in the study pane toolbar.

A notification dialog appears indicating that the retrieval process has begun. You can view the
progress of the retrieval in the Activity Monitor. For more information, see Working in the Activity
Monitor.

Depending on the size and number of studies you selected, it may take some time to fully retrieve them. As
soon as the first images from a study are retrieved, the study appears in the My Studies list. You can open
the study in Investigate mode immediately, but only images that have been retrieved will be visible. The
study must be fully retrieved before you canworkwith it in Plan mode.

2.3.2 Importing from a CD, DVD, or USB Flash Drive
Use the My Computer tab to locate and import study data stored on an external media source such as a
CD or USB flash drive.
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Figure 6 My Computer tab

To import a study from a CD, DVD, or USB flash drive:

1. Insert the CD, DVD or USB flash drive into the optical drive or USB port on the Modus Plan computer.

2. If youwant to import all the files on the CD, DVD or USB flash drive, select Yes in the dialog that
appears.

If youwant to import only some of the files, select No and continue to the next step.

3. On the Explorer tab, click theMy Computer tab.

4. In the tree view on the left, navigate to the location of the study.

5. In the right pane, right-click on the folder or individual image youwant to import and select Import.

2.4 Workingwith Studies
The toolbar at the top of the studies pane contains tools for working with studies.

TIP: These tools are also available from the context menuwhen you right-click on a study.

Figure 7 Study explorer tools

1 Open the selected study or studies.

2 Send the selected study or studies to a remote DICOM server.
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3 Remove the selected study or studies from the local database. It is a good idea to remove unneeded studies
regularly to ensure there is sufficient disk space available for new studies.

NOTE: When a study is removed from the local database, any planning workflow data associated with the study
is also deleted from the Modus Plan workstation. You will not be able to resume the planning workflow, even if
the study is imported into the local database again.

4 Display information about the series in the selected study. For more information, see 2.4.1 Series Details on page
19.

5 Process the study for use in Plan mode.

6 Anonymize the selected study. For more information, see 2.4.2 Anonymizing a Study on page 20.

7 Write the selected study or studies to a portable media device such as a DVD or Blu-ray disc. For more
information, see 2.4.3 Writing a Study to a CD, DVD, or Blu-ray Disc on page 20.

8 Open the Study Filters tab where you can quickly locate specific images in the selected study or studies using
filter criteria. For more information, see 2.4.5 Using Study Filters on page 24.

9 Export the selected study or studies to a USB flash drive. Note that this icon is only available when a USB flash
drive is connected to the Modus Plan computer. For more information, see 2.4.4 Exporting to a USB Flash Drive
on page 22.

2.4.1 Series Details
Click Series Details in the studies pane toolbar to view information about the selected study and the series
it contains. The Series Details dialog that appears also contains tools for sending individual series to a
remote DICOM device, deleting series in the study, and processing series for use in Plan mode.

Figure 8 Series Details dialog

1 Information about the study appears here.

2 The series in the study are listed here.

NOTE: In the exported plan, if there are any accepted merged series with existing Synaptive priors that are
manually adjusted, the system will append a suffix number at the end of the series description to easily distinguish
between different series.
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3 Retrieve the selected series from a remote DICOM device (if the study is not already in the local database).

4 Send the selected series to a remote DICOM device.

5 Delete the selected series from the study.

6 Export the selected series to a USB flash drive. Note that this icon is only available when a USB flash drive is
connected to the Modus Plan computer. For more information, see 2.4.4 Exporting to a USB Flash Drive on page
22.

7 Process the selected series for use in Plan mode. For more information, see 4.1.1.3 Using an Alternate Series for
Planning on page 43.

TIP: The series tools are also available from the context menuwhen you right-click on a series.

NOTE: The context menu also contains a Define MR Protocol option. This feature is for Synaptive Service
use only.

2.4.2 Anonymizing a Study
To create an anonymized copy of a study:

1. Right-click the study in the My Studies list and select Anonymize from the context menu.

Figure 9 Anonymize Study dialog

2. In the Anonymize Study dialog, enter the information to replace
the actual study information. If you leave a field empty, that
field will be blank in the anonymized study.

3. Select the Preserve Series Data option if youwant to preserve
the series level data, as per DICOM 3.0 standard.

4. Select the Keep Private Tags and/or Keep Reports and
Attachments options if youwant to retain that information in
the anonymized study.

NOTE: Youmust select the Keep Private Tags option if you
want to use the study in Plan mode; however, Modus Plan does
not anonymize patient data in private tags or in attached
reports or files. This creates a risk of exposing protected
health information (PHI). It is recommended that you do not
keep reports and attachments in the anonymized study.

In the confirmation dialog that appears, click Yes to retain the
selected information.

5. ClickOK. A new study is generated and appears in the My
Studies list.

6. If necessary, delete the original, non-anonymized study.

2.4.3 Writing a Study to a CD, DVD, or Blu-ray Disc
If you need to share a study, you canwrite it to a portable media device such as a CD, DVD, or Blu-ray disc.
If necessary, you can also include a DICOM viewer on the media along with the study so that it can be
viewed on a computer that does not have a DICOM viewer already installed.
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NOTES:

l Distributing studies on portable media presents a risk to patient privacy. Ensure that studies are only
made available to appropriate parties.

l Although re-recordable media formats such as DVD-RW and BD-RE are supported, data erased from
these media can sometimes be recovered, which may lead to breaches in patient privacy. For this
reason it is not recommended that you copy data to re-recordable media formats.

To write a study to a portable media device:

1. Right-click the study (or studies) in the studies pane and selectWrite to Media in the context menu.

2. In the Media Writer panel, specify the settings for writing to the media, then clickWrite.

Figure 10 Media Writer panel

1 Select the items to write to the disc. Expand a
study node to select individual series in the
study.

2 Click Clear All to remove all studies from the
Selected Studies list.

3 The media will be identified by the value in the
Volume Name field when the recipient inserts it
into their computer. Enter a new name or leave
the default name.

4 Click Additional options to configure Media
Writer options. For more information, see 2.4.3.1
Media Writer Options on page 22.

5 Before writing to the media, Modus Plan copies
the study images to a staging folder. If the
Media Writer feature is not configured to delete
the files in the staging area after writing them
to the disc, click Explore To to open the staging
folder and view the files. For more information
about configuring the Media Writer feature, see
2.4.3.1 Media Writer Options on page 22.

6 Select the disc drive to write to.

7 Click Eject to eject the disc in the selected drive.

8 The amount of disc space available and the
amount of space required for the selected
studies is displayed here.

9 The write progress is displayed here.

10 ClickWrite to write the selected studies to the
disc.
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3. To make multiple copies of the media, eject the disc from the drive, insert a blank disc and clickWrite
again.

NOTE: Do not close the Media Writer panel while writing is in progress. If necessary, you can unpin the
panel and work in the workspace while writing is in progress.

2.4.3.1 Media Writer Options

ClickAdditional options in the Media Writer panel to configure how the Media Writer feature behaves.

Figure 11 Media Writer Options dialog

1 Specify where the files should be copied before they are written to the disc.

NOTE: The staging folder may require considerable disk space. To avoid exceeding the maximum disk usage
(which would cause the workstation to stop importing or receiving studies) it is preferable to configure the
staging folder on a drive not used by the local file store. For more information about configuring the local file
store, see Figure 93 Study Storage options on page 98.

2 Select Include ClearCanvas Workstation, Portable Edition if you want to include the ClearCanvas DICOM viewer
on the disc.

You can also configure whether the ClearCanvas DICOM viewer should display ideographic and/or phonetic
names in the study list.

3 Specify whether to delete the staged files after they are written to the disc.

4 Specify whether to verify whether the files were correctly written to the disc. Note that verification can take a
long time.

5 Select Eject media after writing if you want Media Writer to eject the disc when writing is complete.

2.4.4 Exporting to a USB Flash Drive
You can export studies, series, and support packages to a USB flash drive.

NOTE: To reduce the risk of exposing protected health information (PHI), it is recommended that you use
an encrypted USB device when transferring data.
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2.4.4.1 Exporting Studies or Series

NOTE: The Export to USB option is only enabled in the toolbar when a USB flash drive is connected to the
Modus Plan computer. When you connect a USB flash drive, a dialog appears asking whether youwant to
import the studies on the drive; click No unless youwant to import the studies on the drive.

To export a study to a USB flash drive:

1. In My Studies, select the study or studies youwant to export to the USB flash drive then click the
Export Study to USB button in the toolbar.

A dialog appears showing the progress of the export.

2. When the export is complete, clickOK to close the dialog.

To export one or more series to a USB flash drive:

1. In My Studies, select the study that contains the series youwant to export and click the View Series
Details button in the toolbar.

2. In the Series Details dialog that appears, select the series youwant to export then click the Export
Study to USB button in the toolbar.

A dialog appears showing the progress of the export.

3. When the export is complete, clickOK to close the dialog.

NOTE: Do not remove the flash drive from the Modus Plan computer before the export is complete. Due
to the limitations inherent in the FAT32 file system, it is not recommended that you use a USB flash drive
formatted with that file system.

2.4.4.2 Exporting Support Packages

A support package may contain information like logs and workflows related to a specific study. Synaptive
Service will use this feature to help troubleshoot any issues that youmay encounter with the system.

To export a support package to a USB flash drive:

1. Plug a USB flash drive into the Modus Plan computer.

2. In My Studies, right-click the study or studies that youwant to export, and then select Export to
USB > Support Package.

3. In the USB Support Package Export Tool dialog, select your export options. You can also set up a
password to secure the files.

4. Click Export.

A dialog appears showing the progress of the export.

5. When the export is complete, clickDone to close the dialog.

The support package is exported as a ZIP file. If you set up a password before the export, you have
to provide the password when you open each file in the folders.
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2.4.5 Using Study Filters
If you need to locate a specific image within a study, use the Study Filters utility to quickly filter the study
images by their DICOM data. To use the Study Filters utility, right-click the study youwant to filter in the
studies pane and select Filter Study in the context menu. The Study Filters utility opens in a new tab.

NOTE: To use the Study Filters utility to filter studies on the workstation but not in the local database,
choose Tools > Utilities > Study Filters. Browse to the location of the study and click OK.

Figure 12 Study Filters utility

1 Click the drop-down arrow to add or remove a filter on this column. In the drop-down menu that appears,
specify the value you want to filter by, or select Clear Filters to remove the filter on this column.

2 This icon indicates that the column has a filter applied to it.

3 Add individual files or a folder of files to the Study Filters list.

4 Remove the selected item or items from the Study Filters list.

5 Export the selected item or items to a directory on the workstation. If you select the Export Anonymized option, a
dialog opens where you can specify the values to use in place of the study data.

6 Open the selected image or images in the Investigate mode workspace.

7 Open the selected file or files in the DICOM editor.

8 If the files are not already in the local database, click Import to Local File Store to import them.

9 Customize the available columns. You can select any DICOM tag available in the open studies to filter by.

10 Remove all filters. To remove only the filter on a particular column, click the drop-down arrow for the column and
select Clear Filters.

11 Toggle between viewing the items with and without filters applied.
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3.0 Working in the Planning Interface

The planning interface is designed to help you create an accurate, effective, surgical plan. The planning
process follows a well defined workflow.

This chapter gives a general overview of the planning interface. For information about creating a plan, see
4.0 on page 39.

3.1 About the PlanningWorkflow
The planning workflow is divided into phases, each phase covering an aspect of creating a surgical plan.
Youmight work on some phases while other users complete other phases. Some phases, like the Review
phase, require you to complete certain tasks before you can proceed to the next phase. Some phases can
be skipped, but to produce the most accurate plan, it is recommended that you complete each phase in
the workflow.

3.1.1 Saving Your Progress
Modus Plan automatically saves your progress on a plan. When you open a study, it opens at the point
where you, or the last user who worked on the study, left off.

NOTE: If power is lost while you are working in Modus Plan, or while Modus Plan is transferring data to
another DICOM device, the data may be unrecoverable.

3.2 About the Planning Interface
The planning interface consists of the workflow ribbon, one or more viewports, and the phase panel.

3.2.1 TheWorkflow Ribbon
The workflow ribbon shows the phases in the workflow for creating a plan.

Figure 13 Workflow ribbon for port procedure planning

The phase color indicates the phase state:

l Blue indicates the current phase

l Black indicates that somework has been done in the phase and any required tasks have been
completed, or that the phase was skipped (if there were no required tasks in the phase). You can go
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back and add or change values in these phases.

l Grey indicates that the phase has not been started, or that the work in that phase is not complete.

3.2.2 Viewports in Plan Mode

Figure 14 Viewports in the Trajectories phase

The number of viewports and the series they contain is set for each phase. These arrangements provide
the best view of the data to complete the tasks for each phase. Viewports are often synchronized so that
actions performed in one viewport (for example zooming in, or showing tractography) are replicated in
the other viewports.

The tools available in each phase appear in the active viewport.

TIPS:

l To expand a viewport to fill the whole workspace, double-click in the viewport or press the X key on
the keyboard. Double-click or press the X key again to restore the viewport to its original size.

l In 2D views where the spatial locator is visible, you can quickly center the image around the spatial
locator by right-clicking in the viewport and selecting Center on Locator. This functionality is
synchronized across all viewports containing a 2D image.
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l Right-click in the viewports to display a context menu that allows you to perform other tasks like
toggling on and off the brain mask and craniotomy visualizations.

l The planning interface includes several tools for changing the visibility of the information overlaid on
the series images in the viewports. Hide the viewport overlays and visualizations such as
tractography, regions, and tool graphics when necessary to obtain an unobstructed view of the
anatomy.

3.2.3 The Phase Panel
The phase panel contains information and options relevant to the task you are currently performing in the
phase.

Figure 15 Phase panel in the
Targets phase

1 Move to the previous phase in the workflow.

2 Move to the next phase in the workflow. Note that in some
phases, this icon is unavailable until you complete the
required tasks in the phase.

3 Undo the last action.

NOTE: Not all actions can be undone. For any action that
cannot be undone, a dialog box appears asking you to
confirm that you want to perform the action.

4 Redo an action after clicking Undo.

5 Change layout icon. Click to switch to an alternate viewport
layout in the workspace.

NOTE: This icon is currently only enabled in the Trajectories
phase.

6 Export Tractography icon. Click to export tractography as a
new DICOM series for use in third-party systems. This icon is
available in all phases except the Merged Series phase.

For more information, see 4.8 Exporting Tractography on
page 74.

7 Change the patient orientation in the viewports. For more
information, see 3.3 Viewport Orientations on page 29.

8 This area displays content relevant to the current phase.

9 Viewport overlay options. For more information, see 3.2.4
Overlays Options on page 27.

3.2.4 Overlays Options
Use the Overlays section of the phase panel to show or hide the merged series, trajectory, region, and
tractography overlays. Note that the overlays options available in the phase panel are limited to those
overlays that are appropriate to the phase you are currently working in.
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Merged Series Overlays Options

Click on a series name in the Merged Series overlay options to show that series in the viewports.

Figure 16 Merged Series overlay options

To view the details of a merged series, right-click on a series from the list.

Trajectory Overlays Options

The Trajectory overlays options appear in the Trajectories phase.

Figure 17 Trajectory overlay options

1 Select Show tool to display the interventional device in
the viewports. You can click and drag the tool 'grip
ring' in the viewports to view tracts that will be
impacted by a possible trajectory.

2 The Tissue Clipping options hide parts of the brain
around the tool in the viewports displaying a solid
view. Hiding the tissue can make it easier to view
affected tracts.

Regions Overlays Options

The Regions overlays options become available when one or more regions have been added to the series.

Figure 18 Regions overlay options

1 Displays each region you created in the Segmentation
phase.

2 Displays the region volume in cubic centimeters (cc).

3 Click the show/hide icon to show or hide this region
in the workspace.

To change the region's color, click on the colored
square and select a new color from the options that
appear. To change the region's name, double click on
the name and enter a new one.

Page 28 of 124 MAN-0680 Revision B

Synaptive Modus Plan User Manual 3.2  About the Planning Interface



Tractography Overlays Options

The Tractography overlays options are available if you accepted the tractography in the Review phase.

Figure 19 Tractography overlay options

1 Select the Intersecting tracts only option to show only those
tracts that intersect a trajectory. (This option becomes available
when a trajectory has been created.) The size of the area
considered for tract intersection is based on the size of the tool
you have selected for the trajectory. When reviewing tract
intersection for the trajectory, always verify that you have the
correct tool selected.

2 Any tract bundles that have been created for this series are
displayed here.

TIP: Right click on the name of a tract bundle and select Show
only this bundle to view the bundle in isolation in the viewports.

3 Show tracts based on direction. Select the options to show or
hide tracts running in the Head-Foot (HF), Left-Right (LR), or
Anterior-Posterior (AP) direction.

4 Move this slider to adjust the number of unbundled tracts
displayed in the viewports based on their FA value and length.
As the slider moves to the right, only longer tracts are displayed.

NOTE: This only applies to unbundled tracts. Tracts in bundles
are not affected by this slider.

5 Move this slider to adjust the number of tracts displayed in the
viewports based on their directionality. As the slider moves to
the right, only tracts that are strongly aligned with the scanner’s
axial, sagittal, and coronal planes are displayed.

NOTE: This only applies to unbundled tracts. Tracts in bundles
are not affected by this slider.

6 Show tracts based on the brain hemisphere.

7 Click the arrows to toggle between viewing the whole brain
tractography and segmented tractography (tract bundles).

NOTE: Modus Plan retains the last specified tractography culling slider positions in the Targets and
Trajectories phases. When youmove between these phases, a notification appears indicating that some
tracts are not being displayed due to the tractography culling settings.

3.3 Viewport Orientations
IMPORTANT: Modus Plan permits two views: radiological and surgical. Misunderstanding the view you are
using could result in a surgical plan on the wrong side of the body.When creating a plan, always confirm
the orientation of the patient using the orientation labels.
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Figure 20 Orientation Selection dialog

Modus Plan can display images in two
orientations: foot-to-head (radiological view)
and head-to-foot (surgical view). When you open
a study, youmust select the orientation youwant
to use.

Click on each of the two orientation
representations and read the description of each
orientation carefully. Be sure to select the correct
orientation for the type of work youwill be doing
on the plan.

If necessary, you can change the orientation
when you are working in Plan mode by clicking
the orientation selection icon in the phase panel.

3.4 Reference Lines in Plan Mode
In several phases, when the workspace contains a solid view of the brain in one viewport, and a 2D slice
view in another viewport, Modus Plan indicates the location of the current slice in the 2D view as a colored
line in the solid view. Different colors indicate the current slice when there are multiple 2D views open in
the workspace.

Figure 21 Colored reference lines in Plan mode
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3.5 Viewport Tools
The tools applicable to the tasks in each phase appear in the active viewport. The tools available depend
on the task youwill perform in that viewport. For example, the Rotate tool is only available in viewports
that contain a solid volume rendering of the anatomy.

You can also access tools and options applicable to the active viewport by right-clicking in the viewport
and selecting them from the context menu that appears.

Tools that involve using the mouse can be assigned to a mouse button. For more information, see 7.1.1
Assigning a Tool to a Mouse Button on page 83.

Tool Description

Stack Click and drag the mouse to stack through the slices and volumes in the series.

l Drag the mouse up or down to decrease or increase the slice index.
l Drag the mouse left or right to stack through volumes.

Alternatively, you can also use the mouse scroll wheel to stack.

Radial Stacking Click in the image and drag the mouse up or down to stack around an axis.

Alternatively, you can also use the mouse scroll wheel to stack radially.

NOTE: To quickly jump to the nearest orthogonal view in a radially stacked
image, right-click in the image and select Snap to Nearest Plane. To switch to
the alternate orthogonal view, right-click in the image (in orthogonal view)
and select Snap to Perpendicular Plane.

Trajectory
Stacking

Click in the image and drag the mouse up or down to stack through image
slices perpendicular to a trajectory. This tool is only available when a valid
target and engagement point have been created for a trajectory and the
Position slider is selected in the phase panel. For more information, see 4.5.4
About the Position Slider on page 69.

Window/Level Click and drag the mouse in the image to adjust the window contrast and
brightness.

l Drag the mouse left or right to adjust the window (contrast) value.

l Drag the mouse up or down to adjust the level (brightness) value.

If window/level presets have been configured, click and hold on tool to select
a preset.

IMPORTANT: The window/level settings may cause sulci to appear wider and
deeper than they are.

Pan Click and drag the mouse to move the image in any direction in the viewport.

Table 3 Viewport Tools
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Tool Description

Zoom Zoom in or out of the image. The zoom level is applied to all 2D viewports.

l Drag the mouse up to zoom in.

l Drag the mouse down to zoom out.

NOTE: Your system may be configured to reverse these directions.

Click and hold on this tool to select a discrete magnification factor.

Rotate Click and drag the mouse to rotate a 3D solid view.

Reset Click to reset the image to its original parameters (zoom, pan, flip, rotation).

Hide Overlays /
Show Overlays

Click to hide the viewport overlays. When this tool is active, it changes to the
Show Overlays tool. Click it to show the viewport overlays.

Click and hold on this tool to select specific overlay elements to show or hide.

Region editing
mode

Click to add or edit regions in the series.

Toggle Region
Graphics

Click to hide or show regions that you have created.

Click and hold on this tool to select a specific region display option to show
or hide.

Bundle edition
mode

Click to add or edit tract bundles in the series.

Toggle
Tractography

Click to show the tract information in the image in all viewports. Click again to
hide the tracts.

Ruler Draws a line on the image and displays its length.

Spatial Locator Adds persistent crosshairs to all viewports.

Table 3 Viewport Tools (continued)
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Tool Description

Spatial Locator
in Targets
Phase

The Targets and Trajectories phases use a custom spatial locator icon in the
viewports for marking target and engagement points. The color of the icon
corresponds to the color of the item in the phase panel.

If youmove the spatial locator outside the allowed area (such as outside the
defined brain tissue area) the icon changes to indicate that you cannot mark
at point at that location.

Spatial Locator
in Trajectories
Phase

Out of bounds
Spatial Locator

Add Use the Add tool to add a target and engagement point.

Set Location Click to move a target, or engagement point to the current spatial locator
position.

Toggle
Extracted
Surface

Click to show a translucent image of the skin surface in the viewport. When
this tool is active, click it again to hide the skin surface.

Click and hold on this tool to display other tools that allow you to see through
and adjust the brain's cortical surface, and to improve the head mask in low
intensity skin images.

For more information, see 3.6.1 Adjusting the Extracted Skin Surface on page
34 and 3.6.2 Adjusting the Brain's Cortical Surface Visualization on page 36.

NOTE: This tool is only available in viewports that contain a 3D solid view.
This tool is not available in the Merged Series phase. The extracted skin
surface view is not available for gantry-tilted series.

Table 3 Viewport Tools (continued)

When the lower-right corner of a tool icon is a white triangle, click and hold on the tool icon to open a
context menuwith additional options for using the tool.

Figure 22 Zoom tool context menu
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3.6 Workingwith the Skin Surface and Cortical Surface
Visualizations
In some phases of the planning workflow, Modus Plan displays a representation of the skin surface and
cortical surface. You can show or hide these visualizations in any viewport that contains a 3D solid view.
You can also edit these visualizations, if necessary. To access the tools for working with these
visualizations, click and hold on the Toggle Extracted Surface tool in the viewport.

Figure 23 Toggle Extracted Surface tool options

1 Toggle Extracted Surface viewport tool. Click and hold to access tools for working with the skin surface and
cortical surface visualizations

2 Toggle Skin Surface. Click to show or hide the skin surface visualization

3 Adjust Skin Surface tool. Click to display additional tools for adjusting the skin surface. For more information, see
3.6.1 Adjusting the Extracted Skin Surface below.

4 Toggle Cortical Surface. Click to show or hide the cortical surface visualization.

5 Adjust Cortical Surface tool. Click to display additional tools for adjusting the cortical surface. For more
information, see 3.6.2 Adjusting the Brain's Cortical Surface Visualization on page 36.

3.6.1 Adjusting the Extracted Skin Surface
The quality of skin surface extraction is impacted by the quality of the scan images. Always carefully
review the extracted skin surface and, if necessary, manually refine or adjust it to improve the head mask
in low skin intensity images.
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Figure 24 Adjusting the skin surface visualization

NOTES:

l This feature is not available on a series processed in versions of Plan before 1.5.

l Changes youmake to the skin surface are for visualization during the planning process only and will
not be exported with the plan.

This feature is only available when all the following conditions are met:

l The primary series is a T1 (the extracted skin surface is always generated from the primary series)

l The study is processed

l The viewport contains a 3D solid view

l The primary series is displayed in the viewport; if a merged series is overlaid on the primary series,
you can toggle the skin surface visualization on and off but you cannot adjust it

To refine the skin surface visualization:

1. Select the 3D solid viewport.

2. Click and hold on the Show Extracted Surface tool.

Figure 25 Tool icons for adjusting the skin surface visualization

3. Select the Adjust Skin Surface icon.

4. In the toolbar that appears, drag the slider to adjust the skin surface as necessary.
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You can also:

l Click the reset icon (curved arrow) to reset the slider to its original position (if you have made
adjustments).

l Click the cancel icon (x) to discard any adjustments that you have made.

5. When done, click the checkmark icon to accept your adjustments.

3.6.2 Adjusting the Brain's Cortical Surface Visualization
You adjust the opacity of the translucent cortical surface visualization to better view regions and tracts.

Figure 26 Adjusting the cortical surface visualization

This feature is only available when all the following conditions are met:

l The primary series is a T1 (the cortical surface is always generated from the primary series)

NOTE: Cortical surface adjustment works better on pre-contrast T1 series.

l The study is processed and contains a brain mask

l The brain mask is accepted

l The viewport contains a 3D solid view

l The primary series is displayed in the viewport; if a merged series is overlaid on the primary series,
you can toggle the cortical surface visualization on and off but you cannot adjust it

To adjust the cortical surface visualization:

1. Select the 3D solid viewport.

2. Click and hold on the Show Extracted Surface tool.

Figure 27 Tool icons for adjusting the cortical surface visualization

3. Select the Adjust Cortical Surface icon.

4. In the toolbar that appears, drag the slider until you get your desired cortical surface view.
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You can also:

l Click the reset icon (curved arrow) to reset the slider to its original position (if you have made
adjustments).

l Click the cancel icon (x) to discard any adjustments that you have made (and have not
accepted by clicking the checkmark icon).

5. When done, click the checkmark icon to accept your adjustments.

NOTE: Changes youmake to the cortical surface visualization are for visualization during the planning
process only will not be exported with the plan.

3.7 Capturing Screen Shots
To capture a screen shot of the viewports, click the camera icon.

Figure 28 Camera icon

NOTE: To maintain the privacy of the patient's protected health information, before capturing a screen
shot use the Show/Hide Overlays tool to hide the DICOM data displayed in the viewports.

To access your screen shots, in the Plan Explorer window click Tools > Explore Screen Captures. A
Windows Explorer window opens where you can view your screen shots and save them to a USB drive.

3.8 Exiting Plan Mode
To exit the Plan mode and return to the study explorer, click the exit icon in the workflow ribbon.

Figure 29 Exit icon

If Modus Plan is not connected to ImageDrive Clinical, your planning session is saved to the local
computer.

If Modus Plan is connected to ImageDrive Clinical, the Save Session and Exit Application dialog appears.
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Figure 30 Save Session and Exit
Application dialog

l If youwant to save your planning session to ImageDrive
Clinical, enter a name for your workflow and enter the
user name and password for the ImageDrive account
youwant to upload the plan to.

NOTE: The User Name field is populated with your user
name by default. If you have previously uploaded a plan
to ImageDrive Clinical during the current session, the
password field is populated by default as well. You can
change the values if necessary.

l If you don't want to save your session to ImageDrive
Clinical, de-select the Save to ImageDrive Clinical

checkbox. Your session will be saved to the local
computer.

Click Save and Exit.

IMPORTANT: It is recommended that you log out of Windows when you are done working with Modus
Plan. This ensures that your login credentials will not be used by other users to upload a session to
ImageDrive Clinical.
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4.0 Surgical Planning

To begin creating a plan, in the study Explorer, right-click a study and then select Open. The study you
select must contain a primary series of the patient's brain (usually a T1 or T2 series) and a DTI series. In the
Workflow Study Launcher dialog, click Plan.

Figure 31 Workflow Study Launcher dialog

NOTE: If the study does not contain the data necessary to create a plan, a notification appears in the
phase panel.

4.1 Review Phase
The Review phase ensures that the quality of the scan images and registered visualizations (brain mask,
diffusion data, and tractography) is sufficient to create an accurate plan. At a minimum, youmust indicate
that you accept the image quality. It is not necessary to accept the brain mask and the diffusion and
tractography registrations, but if you do not accept them, they will not be available in subsequent
workflow phases.

If Modus Plan is not able to generate the visualizations, or if the visualizations are not adequate, you can
still use the series to plan. For more information, see 4.1.1.2 Using a Series with No Brain Mask to Plan on
page 42.

NOTE: At any point during the planning workflow, you can return to the Review phase and revoke your
acceptance of the image data and the visualizations. However, if you do so youwill lose any plan data you
created in subsequent phases.

4.1.1 Reviewing the Primary Series and Brain Mask Quality
The accuracy of the plan depends on the quality of the images it is based on. The series used to create the
plan should clearly show the complete brain.

The brain mask indicates the margins of the brain in the scan images. In the scan images, the brain is
highlighted in brown and the skull and other areas outside the brain are cyan.
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Figure 32 Workspace for reviewing image quality and the brain mask

1 Select the series you want to review. Series that have enhancement such as tractography associated with them
appear in bold text in the list.

2 Stack through the images in the viewport and evaluate the quality of the images and the accuracy of the brain
mask.

3 Optionally, click the Play icon to animate stacking through the slices.

4 If necessary, adjust theMask slider to dilate or erode the brain mask until it more closely corresponds to the brain
surface.

5 Reset theMask slider to its original position.

6 Optionally, click the Edit icon to make specific edits to the brain mask. For more information, see 4.1.1.1 Editing
the Brain Mask on page 41.

7 If the brain mask is inadequate, even after making adjustments, clear the Toggle Brain Mask checkbox to proceed
without using a brain mask.

8 When you are satisfied that the image quality is acceptable and the brain mask is adequate (or you have decided
not to use a brain mask for this plan), click the Accept selected series checkbox to proceed.

IMPORTANT:

l Accepting poor quality series may impede location of appropriate surgical targets and regions of
interest.

l Using image data that does not cover the complete brain may prevent selection of the optimal
surgical plan.

l Accepting an image series with low resolutionwill impact the accuracy of the surgical plan.

l Accepting a brain mask that excludes part of the brain may result in a trajectory that originates
beneath the surface of the brain.

l Accepting a brain mask that includes part of the skull may result in diffusion tracts located outside
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of the brain. Depth to target calculations may be incorrect and sulci may be occluded in certain
phases of planning.

To review the series for image quality and brain mask accuracy:

1. In the right viewport, stack through the images to ensure that they are sufficient to create a plan on.

If the image quality is not adequate or the scan does not cover the whole brain, use a different series.
If another series has already been processed, select that series from the Series Data list; if not, follow
the instructions in section 4.1.1.3 Using an Alternate Series for Planning on page 43 to process
another series.

2. Review the accuracy of the brain mask and adjust if necessary:
a. In the right viewport, stack through the images and verify that the brain mask has been

accurately generated.

b. If necessary, adjust theMask slider in the phase panel to dilate or erode the brain mask until it
more closely corresponds to the brain surface, or click the Edit icon to edit only specific areas
of the brain mask.

This will set the default brain mask for the rest of the planning phases.

NOTE: The brain mask does not need to correspond exactly to the brain tissue on all slices. In
the Trajectories phase, youwill be able to further dilate or erode the brain mask to improve its
accuracy in the areas relevant to the procedure before you specify an engagement point.

If the brain mask is not adequate, even after making adjustments, try using another series or another
study. For information, see section 4.1.1.3 Using an Alternate Series for Planning on page 43. If no
other series or study is available, clear the Toggle Brain Mask checkbox to proceed without a using a
brain mask. For more information, see 4.1.1.2 Using a Series with No Brain Mask to Plan on page 42.

3. If you are satisfied with the image quality and brain mask (or are willing to proceed without brain
mask), click the Accept selected series checkbox.

To hide the brain mask visualization, right-click in one of the viewports, and then select Toggle Brain Mask.

4.1.1.1 Editing the Brain Mask

If the automatically-generated brain mask is not accurate, and adjusting it globally using the Mask slider
cannot correct the problem, you canmake edits to specific areas of the brain mask.

Figure 33 Brain mask editing tools

1 Paint brush tool.

2 Eraser tool.

3 Tool size slider. Move the slider to adjust the size of the active tool (paint brush or eraser).

4 Auto-fill mode. When auto-fill mode is enabled, Modus Plan will connect the end point to the start point of a line
you draw with the paint brush tool and automatically fill in the area.
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5 Push/pull mode. Click this tool to set the tool mode based on the way you move the mouse.

When this tool is activated, when you click anywhere inside the mask and drag outside the mask, the tool acts
like the paint brush and extends the mask. When you click anywhere outside the mask and drag inside the mask,
the tool acts like the eraser and removes that part of the mask.

6 Interpolate Changes. Click this icon to incorporate the changes you made into the brain mask.

To edit the brain mask:

1. Click the Edit icon beside the Mask slider in the phase panel. The editing tools appear in the right
viewport and new options appear in the phase panel.

2. In the right viewport, stack to the first slice where the brain mask is not accurate and use the editing
tools to correct the mask.

NOTE: Correct only one area of the mask at a time. If multiple areas of the mask require correction,
complete steps 2 to 4 for one area, then repeat the process for the next area.

3. Stack to a subsequent slice where the mask is not accurate and use the editing tools to correct the
mask. Repeat this process on a representative number of slices that cover the area youwant to
correct.

4. Click the Interpolate Changes icon in the toolbar. Modus Plan creates a new smooth brain mask
surface by filling in the areas between the slices you edited based on your changes.

5. When you are done making edits, clickAccept Edits in the phase panel. The left viewport updates to
show the updated brain mask.

Or, if youwant to discard your changes, click Cancel Edits in the phase panel. This will discard any
changes you have made and have not accepted.

To discard all changes and restore the brain mask to its originally generated state, click Reset in the
phase panel.

NOTE: The edits youmake to the brain mask will not be exported with the plan. Any engagement points
you create based on the edited brain mask will be exported at the locations where you placed them, but
they may not appear to be on the brain surface when viewed in BrightMatter Guide.

4.1.1.2 Using a Series with No Brain Mask to Plan

Under certain circumstances, a brain maskmay not be available for the series youwant to use to create a
plan or Modus Plan may create a brain mask that is not adequate and cannot be fixed using the Mask slider
or mask editing tools. In this case, you can choose not to accept the brain mask and create a plan without
one.

If the series youwant to plan on does not have a brain mask associated with it, the Mask slider and
acceptance checkbox are not displayed.
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Figure 34 Workspace for reviewing a series with no brain mask

1 Review the images in the viewports to verify that the series contains sufficient information to create a plan.

2 If the series is acceptable, click the Accept selected series checkbox.

If the series has a brain mask associated with it, but the brain mask is not adequate for planning purposes,
clear theMask checkbox before clicking the Accept selected series checkbox (see items 6 and 7 in Figure
32).

NOTE: If you accept a series without a brain mask, some features will be limited in the subsequent
workflow phases, diffusion tracts may appear beyond the surface of the brain, and the skull may be visible
in some viewports, obscuring the surface of the brain.

4.1.1.3 Using an Alternate Series for Planning

The Modus Plan workflow is based on a 'primary series'. This is the series that Modus Plan performs image
processing on (to generate visualizations such as the brain mask and tractography) and is the series that
becomes the basis for your exported plan. By default, Modus Plan assumes that the T1 series with the
highest spatial resolution is your primary series. If a study contains multiple series with the same spatial
resolution, Modus Plan uses the most recent series as the primary series. If image processing on that series
fails, Modus Plan attempts to use another T1 series or a T2 series if no other T1 series exist (or if image
processing failed on all T1 series). Modus Plan continues this process until all T1 and T2 series have been
exhausted.

NOTE: Your system may have been configured at installation to use a T2 series as the primary series
instead of a T1 series.

To specify a particular series as the primary series for planning:

1. Exit Plan mode if it is open and return to the My Studies pane.

2. Right-click the study containing the series youwant to use and select View Series Details.
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3. In the Series Details dialog, select the primary series and the diffusion series youwant to use for
creating the plan.

NOTE: If it is not easy to identify the correct diffusion series from the series names, you can select all
the series (CTRL+A) then de-select the T1 or T2 series that you do not want to use for planning (hold
down the CTRL key while you click on the series names). Modus Plan automatically uses the
appropriate diffusion series for processing.

4. Click Process Series in the dialog toolbar.

When processing is complete, you can select the series from the Series Data list in the Review phase panel.
Series that have processed data associated with them appear in bold text in the Series Data list.

NOTE: Processing may take up to 30 minutes to complete. 

4.1.2 Diffusion
During processing, Modus Plan creates three diffusion series: Apparent Diffusion Coefficient (ADC),
Fractional Anisotropy (FA) and an RGB color map. (For diffusion tensors with high anisotropy, the major
eigenvector direction is generally assumed to be parallel to the direction of white matter tract. This is
often represented using an RGB (red-green-blue) color map to indicate the eigenvector orientations.)

When you have accepted the primary series, the workspace updates with four viewports to help you
evaluate the diffusion data. The top-left viewport displays the primary series, the top-right and two
bottom viewports display different visualizations of the diffusion data.

Stack through the slices to verify the quality of the diffusion data. You can also click the Play icon in the
phase panel to animate stacking through the slices in the series. If the diffusion data is not perfectly
registered to the anatomy, you can still accept it and adjust it when you review the tractography data. For
more information, see 4.1.3 Tractography on page 46.
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Figure 35 Workspace for reviewing diffusion data

1 Use the Spatial Locator to follow anatomical structures in the viewports.

2 Optionally, click the Play icon to animate stacking through the slices.

3 If the diffusion data is adequate, click the Accept Diffusion checkbox.

IMPORTANT: Accepting series with poor registrationwill lead to inaccuracy in plans and surgery.

NOTE: By their nature, diffusion scans represent anatomy differently than T1 scans. In some cases, this
may cause the diffusion data to appear to be incorrectly registered to the anatomy. In the ADC image on
the right below, the margin of the tumor appears to extend beyond the margin indicated in the T1 scan on
the left, however this is a characteristic of ADC visualizations.

Figure 36 Comparing the lesionmargin in the T1 and ADC series

Use careful clinical judgment and look for very clear anatomical structures when evaluating the diffusion
data.

NOTE: It is not necessary to accept the diffusion data to continue with the planning process, however if
you do not accept the diffusion data in this phase, youwill not be able to see it in other planning phases.
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4.1.3 Tractography
When you have accepted the diffusion data for the series, the workspace updates with four viewports to
help you evaluate the tractography data generated for this series.

NOTE: If during processing Modus Plan detects that the image data in the primary series is of poor quality
or is incomplete (for example if part of the head is missing), tractography data will not be generated for
the series.

IMPORTANT:

l Tract information displayed in Modus Plan is based on diffusion data; it does not necessarily
correspond to nerve bundles.

l The diffusion tract colors are based on the axes of the scanner. If the patient’s head is not aligned
with the scanner, the colors will not map to the patient axes. If necessary, you can change the tract
RGB coloring to match the patient's orientation instead of the scanner's orientation. For more
information, see Adjusting the Tractography Registration on page 48.

If the tractography does not appear to be correctly registered to the anatomy, you canmove it or scale it
to correct the issue. For more information, see Adjusting the Tractography Registration below.

When you are satisfied that the tractography data registration is adequate, click the Accept Tractography
item in the phase panel.

NOTE: If the automatic tractography segmentation feature is enabled on your Modus Plan system, see
Working with Automatically Segmented Bundles in the Review Phase on page 78.

Figure 37 Workspace for reviewing tractography

1 Use theWindow/Level tool to reduce the brightness in this view (right-click and drag down). This will hide the
brain tissue and reveal the tractography. Rotate the view to review the tracts from all angles.
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2 It can be easier to view the tracts in 2D slice mode. Stack through the slices in this viewport to view the tracts
overlaid on the anatomy.

3 Optionally, click the Play icon to animate the images in the viewports. The solid image in the left viewport rotates
and the 2D image in the right viewport stacks through the slices.

4 Click to show or hide the tractography adjustment controls.

5 When you are satisfied that the tractography data is adequate, click the Accept Tractography checkbox.

IMPORTANT: Accepting series with poor registrationwill lead to inaccuracy in plans and surgery.

NOTE: Accepting the tractography data is not required to continue with the planning process, however if
you do not accept the tractography data in this phase, youwill not be able to see it in other planning
phases.
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Adjusting the Tractography Registration

To adjust the tractography registration:

1. In the phase panel, click the Tractography Adjustment Controls icon. The tractography adjustment
controls appear in the phase panel.

Figure 38 Tractography
adjustment controls

1 Select this option to change the tract RGB coloring to match the
patient's orientation instead of the scanner's orientation (for
example if the scan was oblique or if the patient's head was not
aligned with the scanner). For more information, see Important
Information about Diffusion Tensor Calculations below.

2 Click the + and – icons to scale the tracts horizontally or
vertically relative to the active viewport.

3 Click the arrows to move the tractography up, down, left or
right relative to the active viewport.

4 Click and hold to “snap” to the original tractography position.
Release the mouse button to jump back to your adjusted
tractography.

5 Click to discard all your adjustments and reset the tractography.

2. When you are satisfied that the tractography is correctly registered to the anatomy, click the the
Accept Tractography checkbox.

NOTE: When you adjust the tractography, the diffusion data onwhich the tractography is based is also
adjusted to match your changes.When you accept adjusted tractography, a confirmation dialog appears
requiring you to accept these changes.

TIP: Zoom in on the image in the viewport to see the effect of your tractography adjustments more
clearly.

NOTE: Noise in the diffusion scan images may cause tractography to appear outside of the brain. Do not
attempt to correct this using the tractography adjustment controls. Use the sliders on the Tractography
overlay options in the phase panel to remove stray tracts caused by noise. For more information, see
Tractography Overlays Options on page 29.
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Important Information about Diffusion Tensor Calculations

Diffusion tensor calculations involve vendor-specific private DICOM tag encodings of gradient direction
vectors, which can be affected by a large number of user configurable scanner settings (for example,
direction of scan, in-plane phase encoding direction, scan orientation, etc.). For best results, follow the
Synaptive MR scan recommendations (listed in document MKT-0008). Contact Synaptive customer service
if you experience any issues or have any concerns. For contact information, see 1.6 Synaptive Customer
Service Information on page 12.

To correct cases where the patient's orientation does not match the scanner's orientation, select the Use
patient orientation option in the tractography adjustment tools to have Modus Plan recalculate the RGB
values based on the orientation of the patient's head. Figure 39 below shows an example of before and
after recalculation.

Figure 39 RGB coloring based on scanner axes (left) and based on patient orientation (right)

4.2 Merged Series Phase
If there are other series pertinent to the procedure you are planning for, or series in other modalities that
youwant to use when planning, you canmerge them with the primary series for the plan. For example, to
view vasculature, which may be blocking a potential engagement point, merge a contrast series with your
primary series.

The Merged Series workspace consists of four viewports. Three viewports display a 2D slice view of the
anatomy in coronal, sagittal, and axial orientations. The fourth viewport displays a solid view (except in
the spyglass comparison mode).

There are two ways to see the merged series overlaid on the primary series:

l Use the spyglass comparison mode

-or-

l Use the color blend comparison mode
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In the spyglass comparison mode, the merged series is displayed in a window overlaid on the primary
series. You can adjust the size or shape of the overlay window by clicking and dragging the "handles" on
the sides and corners of the window. To adjust the window/level values of the merged series, change the
window/level values in the 2D view displayed in the bottom right viewport.

Figure 40 Spyglass comparisonmode

1 Merged series overlay window

2 Show/Hide Series Comparison Graphic.
This tool shows or hides the overlay
window.

In the color blend comparison mode, the merged series has a different color from the primary series. The
following example shows a manually adjusted merged series.

Figure 41 Color blend comparisonmode

1 Primary series (amber)

2 Merged series (blue)

4.2.1 The Merged Series Phase Panel
The Merged Series phase panel displays the list of series that you have merged with the primary series.
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Figure 42 Merged Series phase
panel

1 Add a merge series.

2 Delete the selected series.

3 Toggle between spyglass and color blend
comparison modes. Click to show the merged series
overlay window.

4 List of merged series according to the study date and
time, arranged in ascending order. Select a series to
see it overlaid on the primary series in the viewports.

TIP: Right-click a series from the list to view the
details of the original series where it is merged from.

5 Link window/level. Click this icon to link the
adjustments made to the window and level values to
the primary or merged series. This item only applies
to color blend mode.

6 Drag the slider to adjust the intensity of images. The
default opacity is 50% for the primary series and 50%
for the merged series. This item only applies to color
blend mode.

7 Click to reset the merged series color blending. This
item only applies to color blend mode.
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Figure 43 Merged Series phase
panel, continued

8 Click the arrows to move the overlaid merged series
up, down, left, or right relative to the active viewport.

9 Click the icon to rotate the overlaid merged series
counter-clockwise.

10 Click the icon to rotate the overlaid merged series
clockwise.

11 Click to discard all your adjustments and reset the
merged series position.

12 Click and hold on this icon to temporarily restore the
original merged series overlay position. Release the
mouse button to reapply your adjustments.

13 Auto-Merge. Click this icon to automatically align
the merged series to the primary series. This icon is
enabled after you have made manual adjustments, or
if the merge was done using the same frame of
reference.

14 Select the checkbox to accept the series and make it
available in subsequent phases.

4.2.2 Merging Series
To merge one or more series with the primary series:

1. In the phase panel, click the Add a series icon to open a list of available studies.

2. In the Merge Prior Series dialog, select the study that contains the series youwant to merge.

Figure 44 Merge Prior Series dialog
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1 Study list. Select the study that contains the series you want to merge.

2 Series list. Click on one or more series to select them for merging.

3 The preview window displays thumbnails of the images in the series. Move the slider to stack through the
images in the series.

4 By default, the study list contains only studies that match the Patient ID of the primary series. Deselect this
option to view all the studies in the local database.

5 Merge button. Click to merge the selected series into the plan series.

IMPORTANT

If you deselect theMatching Patient ID Only checkbox, the list of available studies contains all
studies in the local database, including studies from other patients. Modus Plan does not perform
any verification to ensure that the study you select is for the same patient as the plan study. Merging
a series from the wrong study may negatively impact clinical decisions.

If you select a study that does not match the Patient ID of the plan study, Modus Plan displays a
notification message when youmerge the study. Review the patient information in the merge study
carefully to ensure that you have selected the correct study.

3. Click on one or more series to select them for merging, and then clickMerge.

TIP: Hold down the CTRL key to select multiple studies.

The merged series appear in the phase panel.

4. Click the name of a merged series to view it overlaid on the primary series in the viewports. The
viewports show the primary series (amber) blended with the merged series (blue).

Carefully review the accuracy of the merge. If the merged series is not correctly aligned with the
primary series, you can do the following:

l Manually adjust the alignment. Use the alignment controls (items 8, 9, and 10 in Figure 43 on
page 52) to move or rotate the merged series.

l Automatically adjust the alignment. Click the Auto-Merge button (item 13 in Figure 43 on page
52) to automatically adjust the alignment of the merged series to the primary series.

If the primary series and the series to be merged have the same frame of reference, the
two series will be immediately overlaid in the viewports.

If the primary series and the series to be merged have a different frame of reference (for
example, merging series of the same patient from two different studies), the system will
do the registration first before merging, which may take longer. Registration only
happens once for this type of merging.

NOTES:

l Merging color series to the primary series is only possible if a series with the same frame of
reference has already beenmerged. You cannot use the Auto-Merge feature for the color
series.

l The system does not support merging of gantry-tilted series.

l Series merged into the primary series in Modus Plan are displayed in BrightMatter Guide. These
series are read-only and cannot be adjusted.
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5. Select the checkbox (item 14 in Figure 43 on page 52) to accept the series and make it available in
subsequent phases.

4.3 Segmentation Phase
Use the Segmentation phase to:

l Define the regions that will be important during the procedure. These may be regions that youwant
to reach during the procedure or regions youwant to avoid.

l Create and edit tract bundles that contain a group of segmented tracts. This will help you plan and
work on select tracts that will be important during the procedure.

NOTE: The Segmentation phase is optional, but highlighting important regions and tracts canmake it
easier to visualize relevant anatomy.

The Segmentation phase workspace consists of four viewports. Three viewports display a 2D slice view of
the anatomy in coronal, sagittal, and axial orientations. The fourth viewport displays a solid view. When
you rotate the solid view, the quadrant (defined by the slices currently displayed in the coronal, sagittal,
and axial views) that is facing you is removed (or "clipped") so you can see inside the solid view.

You canmanually adjust the quadrant clipping bymoving each frame in the 3D solid view. The three
frames (indicated by colors respective to the orientations) represent the 2D slice views and any
adjustment to each frame will apply to each slice in the other three viewports. To hide the frames, right-
click in the 3D solid viewport, and then select Toggle Frames.

Modus Plan can display up to eight regions at once. To add additional regions when eight regions are
visible, hide a visible region by clicking the Show/Hide Region icon in the phase panel.

Figure 45 Viewport layout in the Segmentation phase
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4.3.1 The Segmentation Phase Panel
The Segmentation phase panel displays the regions and tract bundles that you have created, including any
merged series in the study.

Figure 46 Segmentation phase panel

1 Region color and name. Click the colored square to assign a
color to the region. The paint brush tool will also appear in
this color in the viewport when editing this region.

Double-click the region name to rename it.

2 Add Region. Click to add a new region in the active viewport.

3 Delete Region. Click this icon to delete the selected region.

4 Toggle Region Visibility. Click this icon to show or hide all
regions.

5 Show/Hide Region. Click this icon to show or hide this
region.

6 Displays the region volume in cubic centimeters.

7 Unbundled tracts. This bundle contains all tracts that have
not been segmented into any other bundle. You cannot
delete this bundle.

TIP: It may be necessary to hide the unbundled tracts to get a
clear view of any bundles that have been added.

8 Tract bundles are listed here.

NOTE: If the automatic tractography segmentation feature is
enabled on your Modus Plan system, the automatically
segmented tract bundles appear in the bundles list. For more
information, see Working with Automatically Segmented
Bundles in the Segmentation Phase on page 79.

9 Add new bundle. Click this icon to add a new tract bundle in
the active viewport.

10 Delete selected bundle. Click this icon to delete a bundle. You
can delete all bundles that have been added except for
unbundled tracts.

11 Toggle Tract Visibilities. Click this icon to show or hide all
tract bundles.

12 Show/Hide Bundle. Click this icon to show or hide this
bundle.

13 Merged Series overlay. You can add or edit regions and tract
bundles on any series that has been merged with the primary
series.

4.3.2 Adding Regions
Use the Region Editing tools in the Segmentation phase to create a region by using the paint brush, 2D
paint can, or 3D paint can tools. To access these tools, click the Region Editing Mode icon in the viewport
that contains the series youwant to create the region on.

NOTE: If the Region Editing Mode icon is not visible in the viewports, verify that a region is selected in the
phase panel.
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Figure 47 Region Editing Mode viewport tool (left) and Region editing toolbar (right)

1 Paint Brush. Use this tool to draw an area on the current slice by clicking and dragging in the viewport.

2 2D Paint Can. Use this tool to quickly fill an area on the current slice based on the surrounding area's brightness.
For more information, see Creating a Region Using the 2D Paint Can below.

3 Eraser. Use this tool to remove parts of a region on the current slice by clicking and dragging in the viewport.

4 3D Paint Can. Use this tool to quickly fill an area on all slices based on the surrounding area's brightness. For more
information, see Creating a Region Using the 3D Paint Can below.

5 Tool size slider. Move the slider to adjust the size of the active tool (paint brush or eraser). The cursor in the
viewports shows the tool size.

6 Auto-fill mode. For more information about using auto-fill mode, see Creating a Region Using the Paint Brush
Tool below.

7 Push/pull mode. Click this tool to set the tool mode based on the way you move the mouse.

When this tool is activated, when you click anywhere inside the region and drag outside the region, the tool acts
like the paint brush and extends the region. When you click anywhere outside the region and drag inside the
region, the tool acts like the eraser and removes that part of the region.

8 Interpolate. Click this icon to build a 3D region from the 2D regions you traced in the viewport.

An empty region is already available in the phase panel by default. If you do not edit this region, it will be
removed automatically. You can use the default empty region or click the Add Region icon in the phase
panel to create a new empty region.

NOTES:

l When using the paint brush or 2D paint can, build only one region at a time.

l To get the best results when using the 2D or 3D paint can tools, when filling a dark region
surrounded with lighter areas, you should select the darkest area in the region.When filling a light
region surrounded with darker areas, you should select the lightest area in the region. Selecting a
point near the edge of an area may result in the fill spilling outside of the desired area.

l The 3D paint can feature will not work on gantry-tilted series.

TIP: When using the 2D or 3D paint can tools, adjust the window/level value to accentuate the difference
between light and dark areas in the image.
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Creating a Region Using the Paint Brush Tool

To create a region using the paint brush tool:

1. Click the Region Edit Mode icon in the viewport where youwant to create the region.

2. Click the Paint Brush tool in the region editing toolbar. You can also click the Toggle auto-fill mode
tool to automatically fill in the area.

For example, when auto-fill is on, if you draw a 'C' stroke using the brush, Modus Plan will connect
the end point to the start point and automatically fill in the area. If auto-fill is off, a non-filled region is
created.

Figure 48 Auto-fill ON Figure 49 Auto-fill OFF

3. Click and drag in the viewport to trace around the region on the current slice.

4. Stack to another slice in the same viewport and repeat the process of tracing the region.

5. With the same viewport active, click the Interpolate icon in the region editing toolbar to build a 3D
region from the 2D regions that you have drawn.
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Creating a Region Using the 2D Paint Can

Use the 2D Paint Can tool to quickly fill an area on the current slice based on the brightness of the area
around the point where you clicked. When you click in the image, all the surrounding voxels of a similar
brightness are added to the region on this slice. You can control how similar the voxel brightness must be
in order to be included in the region by adjusting the Threshold slider in the toolbar.

Figure 50 2D paint can tools

1 2D Paint Can tool.

2 Threshold slider. Move the slider to adjust the sensitivity of the tool.

3 Interpolate. Click this icon to build a 3D region from the 2D regions you traced in the viewport.

To create a region using the 2D paint can tool:

1. Click 2D Paint Can in the toolbar.

2. Click an area to start creating a region on the current slice. You canmove the Threshold slider to the
expand or reduce the fill of adjacent areas.

In the following example, a light area is initially selected with the threshold adjusted to a higher value
to fill in adjacent areas with similar brightness.

Figure 51 2D Paint Can

3. Stack to another slice in the same viewport and repeat the process of filling in the desired area on
that slice.

4. Click the Interpolate icon in the region editing toolbar to build a 3D region from the 2D regions that
you have drawn.
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Creating a Region Using the 3D Paint Can

Use the 3D Paint Can tool quickly fill an area on all slices in the image based on the brightness of the area
around the point where you clicked. When you click in the image, all the surrounding voxels of a similar
brightness are added to the region. You can control how similar the voxel brightness must be in order to
be included in the region by adjusting the Threshold slider in the toolbar.

Figure 52 3D paint can tools

1 3D Paint Can tool.

2 Cancel paint can edit. Click to remove the 3D region fill.

3 Finish paint can edit. Click to create the region.

To create a region using the 3D paint can tool:

1. Click the 3D Paint Can tool in the toolbar.

2. Click an area in the image to start creating a 3D region. You canmove the Threshold slider to expand
or reduce the fill of adjacent areas.

In the following example, a dark area is initially selected with the threshold adjusted to a higher value
to fill in adjacent areas with similar intensity.

Figure 53 3D Paint Can

3. Click the Finish paint can edit tool.
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Figure 54 Regions - Refining
surfaces message

WhenModus Plan generates a 3D region, it immediately generates a
coarse surface, then it generates a refined surface with a higher
resolution. Generating the refined surface can be slow for a series
with very large region volumes, but you can continue working while
this is in process. If the surface is clinically relevant for the
procedure, wait for the surface refinement to complete, and then
review the surface before exporting. You can check the status in
the phase panel. When the system completes the surface
refinement, the "Refining surfaces" status disappears.

4.3.3 WorkingWith Tract Bundles
Use the Bundle Editing Mode tools to segment tracts into bundles. To access the these tools, click the
Bundle Editing Mode tool in a viewport.

NOTE: The Bundle Editing Mode tool is only available if you have accepted the tractography data in the
Review phase. To enable the tools, a bundle must be selected in the phase panel (not the unbundled
tracts).

Figure 55 Bundle Editing Mode viewport tool (left) and Bundle Editing Mode toolbar (right)

1 Tract Selection. When this tool is selected, click and drag in the viewport to manually select tracts by drawing a
ring around them. Hover over the ring to display additional features for working with the ring (see below).

2 Add Selected Tracts. Click to add the currently selected tracts to the bundle.

3 Remove Selected Tracts. Click to remove the currently selected tracts from the bundle.

NOTE: To prevent tracts from being removed accidentally, only tracts that are currently visible in the viewport
can be removed from the bundle.

4 AND/OR Tract Selection. If you are using multiple rings to select tracts, click this icon to toggle between showing
tracts that intersect each ring, and showing tracts that intersect all rings.

5 Region Intersection mode. Click to select any tracts that intersect a region.

6 Margin slider. Move the slider to adjust the region intersection margin. This slider is only available when Region
Intersection mode is enabled.

7 Affinity slider. Move the slider to show or hide tracts based on their "affinity" to the bundle's definition. For more
information, see About the Affinity Slider below.

8 Cancel Selected Tracts. Click to cancel the edits you made to the tract bundle.

9 Accept Selected Tracts. Click to save the edits you made to the tract bundle.
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Figure 56 Tract Selection ring
features

1 Click this icon to return to the slice where you placed the ring. Use this
feature if you have stacked through the image and want to return to the
original slice you were working on.

2 Click this icon and drag in any direction to move the ring in the current
slice.

3 Click this icon and drag to rotate the ring along the selected tracts.

4 Click this icon and drag in any direction to adjust the ring size.

5 Click to close the ring tool.

To add or edit a tract bundle:

1. Select the bundle youwant to edit, or click the Add new bundle icon in the Segmentation phase
panel.

2. In a viewport, click the Bundle Editing Mode tool.

3. Use the bundle editing tools to select the tracts youwant to add or remove from the bundle.
Selected tracts are highlighted in the viewport.

4. When the tracts youwant to add or remove are highlighted, click the Add Selected Tracts icon or
the Remove Selected Tracts icon to add or remove the tracts from the bundle.

5. When you are done selecting tracts, click the Accept Selected Tracts tool.

NOTE: Tracts that have been segmented cannot be culled using the culling sliders in the Tractography
overlay options. If culling was applied before the tracts were segmented, that culling cannot be undone
after the segmented tract bundle has been accepted.

About the Affinity Slider

Use the Affinity slider to show or hide tracts in a bundle based on their similarity (or "affinity") to the
bundle as a whole. Move the slider to the left to show tracts with a lesser affinity to bundle (so youwill see
more tracts in the bundle). Move the slider to the right to show only those tracts that have a high affinity
to the bundle.

NOTE: When you increase the affinity, the tracts removed from the bundle are moved to the unbundled
state.When you decrease the affinity, the tracts added to the bundle are taken only from the unbundled
tracts, not from other bundles.

4.3.4 Assigning a Color to Regions and Tract Bundles
To assign a color to each region and tract bundle, click the colored square beside the region or the
colored tract icon beside the bundle and then select your desired color.
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Figure 57 Assigning a color to a region

4.4 Targets Phase
In the Targets phase, define the target or targets youwant to reach during the procedure. Youmust
create at least one target before you canmove to the next phase. You can return to this phase to add new
targets if necessary. You can also adjust the location of a target in the Trajectories phase.

The Targets phase workspace contains four viewports. Three viewports display a 2D slice view of the
anatomy in axial, sagittal, and coronal orientations. Move the spatial locator in these viewports to specify
the location of the target. The fourth viewport displays a solid view.
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Figure 58 Viewport layout for placing targets

1 Position the spatial locator where you want to place a target and click the Add icon (item 2).

2 Click to add a target at the current spatial locator position.

3 Targets are represented by crosses on the image. Their color corresponds to the target item in the phase panel.

4 Set Location icon. Click this icon to move an existing target to the current spatial locator location.
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4.4.1 Placing Targets

Figure 59 Targets phase panel

1 Modus Plan creates a trajectory for each target you add.
Select a trajectory from the drop-down list to view or edit its
properties.

2 Add a trajectory for this target point. Click to add a trajectory
at the current spatial locator position. This option is also
available as a tool in the active viewport.

3 Edit properties for the selected trajectory. Click to edit the
trajectory name and color. You can also edit the properties of
the selected trajectory in the Trajectories, Craniotomy, and
Export phases.

4 Copy the selected trajectory. Add a new trajectory by
copying the currently selected one. The new trajectory is
added at the same location as the selected trajectory. Use this
option if you want to evaluate two trajectories to the same
target location.

5 Delete the selected trajectory.

6 Set target point. Click to move the target to the current spatial
locator position. This option is also available as a tool in the
active viewport.

7 You can add an engagement point for this target in the
Targets phase, but it is recommended that you add
engagement points in the Trajectories phase.

To place a target, in one of the 2D viewports drag the spatial locator to the location where youwant to
place the target and click the Add a trajectory for this target point tool in the viewport or in the phase
panel. If you attempt to drag the spatial locator to an invalid location (such as a location outside of the
brain), the spatial locator icon changes and the Add a trajectory for this target point tool is disabled.

NOTE: If you are planning without a brain mask, Modus Plan cannot prevent you from placing a target
outside of the brain. However, if you place a target outside of the brain, or on the surface of the brain, the
resulting trajectory will not be usable in BrightMatter Guide. Always place targets within the brain volume.

Once you have added a target, the Set target point tool becomes available. To move a target, drag the
spatial locator to the new location and click the Set target point tool icon in the viewport or in the phase
panel.

Page 64 of 124 MAN-0680 Revision B

Synaptive Modus Plan User Manual 4.4  Targets Phase



4.5 Trajectories Phase
In the Trajectories phase, define the engagement point where youwill enter the brain to reach a target
during the procedure. The target and the engagement point together comprise a trajectory. You can
create one engagement point for each target you created in the Targets phase. If necessary, you can
adjust the location of your targets in the Trajectories phase.

Youmust create at least one complete trajectory before you canmove to the next phase. You can return
to this phase to adjust your trajectories if necessary.

Figure 60 Default viewport layout for placing engagement points

1 Drag the spatial locator and observe the tractography to locate a suitable engagement point.

2 The projected trajectory between the target and the current position of the spatial locator is displayed as a
colored line. The color corresponds to the color of this trajectory in the phase panel.

3 Adjust theMask slider in the phase panel until the brain mask corresponds directly to the surface of the brain.

4 This viewport displays a trajectory-centric 2D view. Stack in this viewport to view the image slices as they
intersect the proposed trajectory.

5 When you have located a suitable position for the engagement point, click the Add icon. This tool is also available
in the phase panel.

TIP: To toggle between showing all trajectories in the viewports or only the currently selected trajectory,
right-click in a viewport and select Show all Trajectories or ShowOnly Active Trajectory. This feature is
available in the Targets, Trajectories, and Craniotomy phases.
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4.5.1 The Trajectories Phase Panel

Figure 61 Trajectories phase panel
(after an engagement point has
been created)

1 Select the trajectory you want to create an engagement
point for from the Trajectories list.

2 Delete this trajectory.

3 Create a new trajectory by copying the selected one.

4 Edit properties for the selected trajectory. Click to edit the
trajectory name and color.

5 Set the engagement point location. Click to move the
engagement point to the current spatial locator position.
This option is also available as a tool in the active
viewport.

If an engagement point has yet not been created for this
trajectory, the Add icon appears here.

6 Adjust the Position slider to simulate moving along the
trajectory. For more information, see 4.5.4 About the
Position Slider on page 69.

7 Add a margin to the tool graphic in the viewports. Use the
slider to view the potential tract intersections over a larger
area of the anatomy. The margin is an extension of the
tool's radius.

Use this feature to evaluate the impact of navigation error
during the procedure and the risk of tool deflection for
very fine tools.

8 Adjust theMask slider until the brain mask corresponds
directly to the surface of the brain in the viewports.

9 Reset the brain mask.

10 The length of the trajectory is displayed here.

11 Click this icon to open the tool selection dialog.

12 The length and diameter of your selected tool are
displayed here.

13 Click this icon to view an alternate hanging protocol with
four viewports; three display 2D orthogonal views and the
fourth displays a trajectory-centric 2D view.

14 Click Target to adjust the target location for this
trajectory. For more information, see 4.5.5 Adjusting a
Target in the Trajectories Phase on page 69.

4.5.2 Placing an Engagement Point
To place an engagement point:

1. In the phase panel, select the trajectory youwant to create an engagement point for.

2. In the left viewport, drag the spatial locator around the brain surface to locate a sulcus that provides
good access to the target. If necessary, hide the tracts in this viewport to make the sulci more
visible.

Observe the tracts in the right viewports to assess the impact of the proposed trajectory.
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When a brain mask exists for the study, the spatial locator in the left viewport is fixed to the surface
of the brain (the only logical place to create an engagement point). You canmove the spatial locator
in the right viewport, but the nature of the 2D view maymisrepresent the actual location of the
engagement point that will be created.

In the 2D view, if youmove the spatial locator off the brain mask, Modus Plan will correct for this by
extending the proposed trajectory to the brain mask and creating the engagement point there. If you
move the spatial locator too far from the surface of the brain, the spatial locator icon changes and
the Add icon is disabled in the viewport and the phase panel.

NOTE: If a brain mask does not exist for the study, the default engagement point created by Modus
Planwill be on the skin surface not the brain. Always move the default engagement point to an
appropriate location on the surface of the brain in the right viewports to ensure that the resulting
trajectory length is accurate for the procedure. If the engagement point is placed too close to the
skin surface, or outside of the skin surface, Modus Planwill not be able to create a craniotomy for
the trajectory.

3. In the right viewports, verify that the brain mask is accurate. If necessary, adjust the Mask slider in the
phase panel to dilate or erode the mask to correspond to the brain surface.

As a result of changing the brain mask, youmay need to repeat the previous step to locate the best
location for the engagement point.

4. When you are satisfied with the position of the spatial locator, click the Add icon in the viewport or
in the phase panel to add an engagement point at the spatial locator position.

5. Click the pencil icon beside the Tool item in the phase panel to open the Tool Selection dialog.

Select a tool type from the list on the left, then select or enter the tool specifications in the options
on the right.

Figure 62 Tool Selection dialog

NOTES:

l If you select a NICO tool and the tool you select is shorter than the trajectory, Modus Plan
displays a notification recommending that you select a longer tool.

l If you select a very small tool, such as a custom tool with a 1 mm diameter, for the best
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accuracy it is recommended that you apply a tool margin when reviewing the trajectory for
intersecting tracts.

l The following tools are not available for use with BrightMatter Guide. You can select these
tools to visualize their effect during a procedure, but they will not be exported with the plan.
When you open the plan in BrightMatter Guide, the trajectory will contain an adjustable tool
and will use the default craniotomy for an adjustable tool.

NICO BrainPath ports 11 mm in diameter

NICO BrainPath ports 95 mm in length

Inspection tools

4.5.3 Adjusting an Engagement Point
Once you have added an engagement point, the Set Engagement Location tool becomes available. To
move an engagement point, drag the spatial locator to the new location and click the Set Engagement
Location tool icon in the viewport or in the phase panel.

Optionally, in the Trajectories overlay options, select Show Tool to display the interventional device in the
viewports. The trajectory runs down the center of the device graphic with the target fixed at the tip. Drag
the grip ring and observe the tractography to evaluate possible trajectories. When you find a suitable
trajectory, click the Set Engagement Location tool icon in the viewport or in the phase panel.

Figure 63 Viewports in the Trajectories phase showing the NICO tool overlay graphic

NOTE: Modus Plan uses the brain mask to determine the location of the surface of the brain for distance
to target calculations. Once you have created an engagement point for a trajectory, if you subsequently
change the brain mask setting for the trajectory, Modus Planmoves the engagement point to correspond
to the new brain surface location. Youmust confirm this new location by clicking the Set Engagement
Location tool icon in the viewport or in the phase panel.
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4.5.4 About the Position Slider
Use the Position slider to simulate the movement of the tool along the selected trajectory. When the slider
is at its leftmost point (0 mm), the tool is at the engagement point; at its rightmost point, the tool is at the
target point. The tool's distance from the engagement point is displayed beside the slider (in mm).

Click the play icon beside the Position slider to animate flying through the trajectory. The animation begins
at the skin surface and continues until the tool is 10 mm past the target.

When the Position slider is selected, the Stack viewport tool in 2D views changes to the Trajectory Stack
tool. Use this tool to stack through images perpendicular to the trajectory.

4.5.5 Adjusting a Target in the Trajectories Phase
As you search for a good engagement point, youmay find that it is necessary to move the location of a
target. You can do this directly in the Trajectories phase:

1. In the phase panel, select the trajectory whose target youwant to edit, and then click Target.

2. In one of the viewports, move the spatial locator to the location where youwant to move the target.

3. Click the Set Target Location tool icon in the viewport or in the phase panel.

4.5.6 Copying a Trajectory
You can create a new trajectory by copying an existing one. To copy a trajectory, select it in the phase
panel, and then click the Copy icon (item 3 in Figure 61). The new trajectory's target and engagement
points, mask, and tool settings, are all identical to the trajectory you copied.

4.6 Craniotomy Phase
In the Craniotomy phase, plan the craniotomy for the surgical procedure and verify that youwill be able to
reach the full extent of the target with the interventional device. Modus Plan automatically draws a
proposed craniotomy for each trajectory in your plan based on the location of the target and the size of
the tool selected for the trajectory. You can adjust the size of the craniotomy, but not its location.

IMPORTANT: Specifying a craniotomy that is too small may prevent sufficient movement of the
interventional device.

When you are satisfied that the craniotomy is the correct size for the procedure, proceed to the Export
phase to export a plan.
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Figure 64 Viewport layout for planning a craniotomy

1 Drag the grip ring on the tool graphic to simulate the reach of the tool. Observe the results in the right viewport.

2 Drag the body of the tool graphic up and down to simulate cannulation.

3 The depth to the target is displayed in the viewport overlay.

4 The craniotomy size is reported as the major axis of an ellipse.

5 Use the radial stack tool in the right viewport to verify that the tool can reach all parts of the region.

6 Show the tractography to see which tracts intersect the path of the interventional device.
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4.6.1 Craniotomy Phase Panel

Figure 65 Craniotomy phase panel

1 Select the trajectory you want to plan a craniotomy for.

2 Adjust the Size slider to change the size of the
craniotomy.

3 Click to recalculate the craniotomy size Modus Plan
estimated for this trajectory.

4.7 Export Phase
In the Export phase, you can do a final review of your trajectories and, if you are satisfied, you can export
a navigation plan for each trajectory.
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Figure 66 Export phase panel

1 Select the trajectory you want to export a plan for.

2 Adjust the Position slider to move the tool along the
trajectory. For more information, see 4.5.4 About the Position
Slider on page 69.

3 Information about the trajectory appears here. You cannot
edit the tool or craniotomy size in this phase. If you want to
change these values, go back to the Craniotomy phase.

4 Click Export Plan to export a plan for this trajectory.

4.7.1 Exporting a Plan for a Trajectory
NOTE: Once a trajectory has been exported, it can no longer be edited. This is a safety measure to ensure
that an incorrect version of a plan is not mistakenly used. However, you can use the Copy feature in the
Trajectories phase to make a copy of the exported trajectory and edit that.

To export a plan:

1. From the Trajectories list in the phase panel, select the trajectory youwant to export a plan for then
click Export Plan.

NOTE: If you selected a NICO BrainPath tool for this trajectory, and the trajectory is longer than the
tool, a dialog appears asking you to confirm that youwant to export the trajectory. Click Yes to
continue with the export.

2. In the Name Plan and Select Destinations dialog, enter a name for the plan, select your export
options, and then clickNext.
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Figure 67 Name Plan and Select Destinations dialog

You can export a plan for use with Guide or export a standard volumetric plan for use with third-
party systems, or both.

NOTE: In the volumetric plan, the target and engagement point are indicated by a bright white spot
with a black background. The volumetric plan has the same name as the default exported planwith
the word “VOLUME” added into it.

3. Specify the location (or locations) where youwant to export the plan.

Figure 68 Plan export options

My Studies: This option is always selected.

PACS Server: Select this option if youwant to export the plan to one or more PACS servers then
select the server (or servers) youwant to export to.

NOTE: If you have configured one or more servers as your default servers, they will automatically be
selected. For information about configuring default servers, see 8.2 System Configuration on page
94.
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USB Key: This option becomes available when one or more USB flash drives are connected to the
Plan computer. Select this option if youwant to export to a USB flash drive, then select the drive (or
drives) youwant to export to.

NOTE: Do not remove the flash drive from the Modus Plan computer before the export is complete.
Due to the limitations inherent in the FAT32 file system, it is not recommended that you use a USB
flash drive formatted with that file system.

4. Click Export.

When you export a plan, Modus Plan creates a new series in the study with the following images:

Figure 69 Bundle image example

l Target references – axial, sagittal, and
coronal renderings centered on the target
with the trajectory projected on the slice

l Trajectory references – axial, sagittal, and
coronal renderings centered on the
engagement point with the trajectory
projected on the slice

l A craniotomy reference – a 3D rendering of
the skull, engagement point, and planned
extent of the craniotomy

l A list of any series that were merged with
the primary series

l An image of each region and tract bundle
that were created as part of the plan

You can open a plan in Investigate mode to
review its details and/or forward the plan to
ImageDrive Clinical or another PACS for review or
reference.

NOTE: When you import the plan into a
navigation system, always review the series in the
plan before starting the procedure to ensure the imported data matches the clinical intent of the plan.

4.8 Exporting Tractography
Use the Export Tractography feature to generate a DICOM series of the tractography data. The
generated series includes the tractography as it is currently displayed in the viewports (tract culling values
and bundle visibility are preserved). The data is always generated in the acquisition plane of the target
series, not in the plane of the selected viewport. For example, if the target series was captured from left
to right, then the generated series will be L-R.

The generated series can contain the whole brain tractography or tract bundles.
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NOTES:

l This feature is only available if you have accepted the tractography in the Review phase.

l This feature is available in all phases except the Merged Series phase.

l Tractography export is designed for use with third-party systems that can display volumetric
DICOM data; it is not the same as exporting a plan.

To export tractography:

1. Use the tools in the Tractography overlays options to set up the tractography in the viewport as you
want to export it.

l If you selectWhole Brain Tractography, all tracts will be included.

l If you select Segmented Tractography, only bundled tracts will be included. If you do not want
to exclude a tract bundle from the export, hide the bundle in the phase panel.

2. Click the Export Tractography icon in the phase panel.

Figure 70 Export Tractography icon

3. In the Export Tractography dialog:

Figure 71 Export Tractography dialog

l If you are exporting the segmented
tractography, from theMode drop-
down list, select whether to export all
the bundles in a single series, or each
bundle in its own series.

If you are exporting the whole brain
tractography, there are no options
available in theMode list.

l Select the Color Setting for the series:
color or grayscale.

l If you are exporting the whole brain
tractography, or the segmented
tractography in a single series, enter a
name for the generated series.

If you are exporting the segmented
tractography with each bundle in its
own series, the series are automatically named with the bundle names.

l Drag the Preview slider to view the image slices. The preview area displays the total number of
image slices in the series and automatically updates when you change the color.

l Use the Tract Settings information to verify that the correct tracts will be included in the
export. Note that you cannot make changes to the tract settings in the Export Tractography
dialog. If youwant to make changes to the tract settings, click Cancel to close the dialog, and
thenmake the necessary tract adjustments in the phase panel.

4. ClickNext.
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5. In the Publish to Local and External Media dialog, specify the location (or locations) where youwant
to send the generated DICOM series and then click Publish.
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5.0 Optional Surgical Planning Features

This section describes separately-licenseable features in Modus Plan. For information about enabling
these features, contact Synaptive customer support.

5.1 Tract-Only Tractography Export
Use the tract-only tractography export feature to export the selected tractography and not the
background image data. For complete information about exporting tractography, see 4.8 Exporting
Tractography on page 74.

Figure 72 Export Tractography dialog

1 This option becomes available when the tract-
only tractography export feature is licensed in
Modus Plan.

To export tractography that includes only tracts
and not the background image data, make sure
this option is not selected.

5.2 Automatic Tractography Segmentation
When the automatic tractography segmentation feature is enabled, Modus Plan automatically generates
the following tract bundles when processing the series for planning:

l Arcuate Fasciculus/Superior Longitudinal Fasciculus

l Cerebellar Peduncle (Inferior)

l Cerebellar Peduncle (Middle)

l Cerebellar Peduncle (Superior)

l Cingulum

l Corona Radiata

l Corpus Callosum
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l Corticospinal Tract

l Fornix

l Inferior Fronto-Occipital Fasciculus

l Inferior Longitudinal Fasciculus

l Optic Radiations

l Uncinate Fasciculus

Working with Automatically Segmented Bundles in the Review Phase

Youmust review and accept the automatically segmented bundles in the Review phase in order to see
them in subsequent phases.

Figure 73 Reviewing and accepting automatic tractography segmentation

1 The automatically segmented tract bundles appear in the Tractography overlays options.

2 Click this icon to toggle the visibility of the tract bundles and unbundled tractography.

3 If you are satisfied with the automatically segmented tract bundles, select this option and proceed with reviewing
and accepting the other tractography.

NOTE: If you want to make changes to the automatically segmented tract bundles you can edit them in the
Segmentation phase, but you must first accept them in the Review phase.

IMPORTANT:

l The quality of the tract bundles created by the automatic tractography segmentation feature
depends on a number of factors including the patient's anatomy and the scan quality. Always review
the tract bundles carefully and adjust if necessary. For more information, see 4.3.3 Working With
Tract Bundles on page 60.

l For additional important information about reviewing tractography, see 4.1.3 Tractography on page
46.
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Working with Automatically Segmented Bundles in the Segmentation Phase

The automatic tractography segmentation feature changes some features in the Segmentation phase. For
complete information about working with bundles in the Segmentation phase, see 4.3.3 WorkingWith
Tract Bundles on page 60.

Figure 74 Segmentation phase
panel showing automatic
tractography segmentation
features

1 Automatically segmented bundles, and all other unbundled
tracts, appear in the phase panel.

2 When editing an automatically segmented bundle, you can undo
your edits and restore the bundle to its automatically-generated
state by clicking the reset icon.

NOTE: Resetting a bundle might affect other bundles. If tracts
were moved from this bundle to another bundle, they will be
removed from that bundle and restored to this one.

Affinity Slider Behavior for Automatically Segmented
Tract Bundles

Bundles that were automatically segmented by Modus Plan when
the series was processed for planning (and have not been edited)
are defined by the processing algorithm. The slider's original
position is set at the middle of its range to account for a margin of
error during processing. You canmove it left or right to show more
or fewer tracts to more accurately represent that bundle.

When youmodify an automatically segmented bundle using the
tract selection rings or region intersection tool, Modus Plan resets
the Affinity slider to the far left of its range and you can only move
it to the right to hide tracts with a lesser affinity to the current
group of tracts in the bundle.
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6.0 Working in Investigate Mode

Use Modus Plan Investigate mode to review images before creating a surgical plan or to view a surgical
plan created in Plan mode.

6.1 Opening Studies in Investigate Mode
To open a study in Investigate mode, double-click on the study in Explorer and select Investigate. The
study and any prior studies associated with it open in the Investigate workspace.

How the study appears in the workspace (for example, the number of viewports visible and what they
display) depends on several Modus Plan options, such as hanging protocol configuration and layout
configuration options.

6.2 About the InvestigateWorkspace
The Modus Plan Investigate workspace consists of the toolbar, one or more viewports, and panels for
working with various Modus Plan features.

Figure 75 The Investigate workspace

1 Investigate toolbar.

2 Viewports. The active viewport is highlighted with an orange border. If the series contains multi-frame images,
the viewport may display the images in “tiles”. The active tile is highlighted in yellow.
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3 An open "pinned" panel.

4 Click the pin icon to hide a panel. You can also double-click the panel title bar to undock the panel and display it
in a separate, moveable, window. Double-click the title bar again to dock the panel in the workspace again.

5 An "unpinned" panel. Unpinned panels appear as tabs in the workspace. Mouse over the tab to open the panel.

The panel remains open while you are working in it. When you click away from the panel, for example in a
viewport, the panel slides away to the edge of the workspace.

To keep a panel displayed at all times, click the pin icon to "pin" it to the workspace.

6.3 Using the Thumbnails Panel to Open a Series in a
Viewport
The Thumbnails panel displays the open studies and thumbnails of the series they contain. Click Show
Thumbnails in the toolbar to open the Thumbnails panel.

Figure 76 Thumbnails panel

The open studies, and any prior studies associated with them, appear in the left pane, grouped by patient
ID. Expand the patient ID node to view the open studies. Select a study to view its series thumbnails in the
right pane.

Drag a thumbnail into a viewport to open the series.

6.4 Viewport Layouts
You can specify the default number of viewports and their configuration in the workspace on the Layout
Preferences page (for more information, see 8.4.4 Layout on page 105).

To change the number and arrangement of viewports in the workspace, click Change Layout in the
toolbar. Click and drag over the boxes to select the desired viewport arrangement.

Figure 77 Selecting a viewport arrangement
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6.5 Viewport Overlays
Modus Plan displays supporting information over-top of the image in a viewport. This can include text
from the DICOM headers in the study, a scale ruler, and other image data.

Figure 78 Viewport overlays

The Text overlay displays information from the DICOM data for the series. This includes information about
the patient, the study, the scanner, and the image series.

To show or hide the viewport overlay text, click the arrow beside the Image Overlays icon in the toolbar
and select or deselect the Text option.
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7.0 Investigate Mode Tools

7.1 Workingwith Tools
You can access Investigate mode tools in the following ways:

l Clicking the tool in the toolbar

l Selecting the tool from one of the sub-menus in the Tools menu

l Right-clicking in the viewport and selecting the desired tool from the context menu

l Using the keyboard shortcut (not available for all tools)

7.1.1 Assigning a Tool to a Mouse Button
By default, certain tools are mapped to the left and right mouse buttons in eachworkflow phase, but
many tools can be temporarily assigned to a mouse button.

To assign a tool to a mouse button, click the tool in the toolbar with the mouse button youwant to use.
Clicking in the image with that mouse button now performs the function associated with the tool.

Figure 79 Tools assigned to mouse buttons

When a tool has been assigned to a mouse button, the toolbar icon for the tool is highlighted and displays
the letter corresponding to the mouse button it has been assigned to (left, right, middle, and others). For
mouse devices with five buttons, the buttons on the left and right edges of the mouse are indicted by the
numbers 4 and 5.

7.1.2 Using Keyboard Shortcuts
Many tools have keyboard shortcuts assigned to them. Mouse over the tool in the toolbar to see the
keyboard shortcut for that tool. The tool icon indicates which mouse button the tool will be assigned to
when you press the associated key. For example, the Zoom tool will be assigned to the left mouse button
when you press the Z key.

Figure 80 Keyboard shortcut information for the Zoom tool
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For a list of the default keyboard shortcuts, see 10.0 on page 114.

7.1.3 Accessing Tool Options
A drop-down arrow appears beside tools that have options associated with them. Click the arrow to
select an option to use with the tool.

Figure 81 Magnification tool options

7.2 Standard Image Tools
Use the following tools to adjust the image in the active viewport.

Tool Description

Survey/Explode Displays the active viewport in the full screen. Select the tool again to restore
the original viewport configuration.

You can also double-click in a viewport to open it in the full screen. Double-
click in the viewport again to restore the original viewport configuration.

Cine Opens a player that animates stacking through the slices in the series. For
more information, see 7.2.1 Using the Cine Player on page 86.

Stack Click and drag the mouse up or down to stack through the slices in the series.

l Click and drag the mouse up or down to decrease or increase the slice
index.

l Click and drag the mouse left or right to stack through volumes.

NOTE: You can also use the mouse scroll wheel to stack.

Table 4 Standard Image Tools
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Tool Description

Window/Level Click and drag the mouse in the image to adjust the window contrast and
brightness.

l Drag the mouse left or right to adjust the window (contrast) value.

l Drag the mouse up or down to adjust the level (brightness) value.

If window/level presets have been configured, click and hold on tool to select
a preset.

NOTE: The window/level settings may cause sulci to appear wider and
deeper than they are.

Pan Click and drag the mouse to move the image in any direction in the viewport.

Zoom Zoom in or out of the image.

l Drag the mouse up to zoom in.

l Drag the mouse down to zoom out.

NOTE: Modus Planmay be configured to reverse these directions. For more
information about specifying preferences for tools, see 8.4.7 Tools on page
108.

Click and hold on this tool to select a discreet magnification factor.

Magnification Magnifies the area of the image immediately under the mouse.

Probe Displays the characteristics of a specific voxel.

Flip Vertical Flips the image vertically.

Flip Horizontal Flips the image horizontally.

Rotate Counter-
clockwise

Rotates the image counter-clockwise.

Rotate
Clockwise

Rotates the image clockwise.

Invert Inverts the colors in the image.

Table 4 Standard Image Tools (continued)
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Tool Description

Reset Resets the image to its original parameters (zoom, pan, flip, rotation).

Hide Overlays /
Show Overlays

Click to hide the viewport overlays. When this tool is active, it changes to the
Show Overlays tool. Click it to show the viewport overlays.

Click and hold on this tool to select specific overlay elements to show or hide.

Add Text Adds a text box to the image. For more information, see 7.2.2 Adding
Annotations on page 86.

Add Text
Callout

Adds an arrow with a text box to the image. For more information, see 7.2.2
Adding Annotations on page 86.

Previous
Display Set

Opens the previous series in the study in the viewport.

Next Display
Set

Opens the next series in the study in the viewport.

Table 4 Standard Image Tools (continued)

7.2.1 Using the Cine Player
Use the Cine player to view an animation of stacking though the images in the series.

Figure 82 Cine player

l Click the forward or reverse icons to start stacking through the images.

l Click the stop icon to stop.

l Move the slider left or right to slow down or speed up the animation.

7.2.2 Adding Annotations
Use the text annotation tools to add comments to an image.
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Figure 83 Image with text and a text callout

7.2.2.1 Add Text to an Image

To add text to an image:

1. Click the Add Text tool in the toolbar (if necessary, click the drop-down arrow beside the Add Text
Callout tool and select the Add Text tool).

2. Click in the viewport.

3. Type your text then press Enter.

4. If necessary, click and drag the text to move it to the appropriate location on the image.

To edit the text, double-click on the text, or right-click on the text and select Edit.

7.2.2.2 Add a Text Callout to an Image

A text callout is a text box with an arrow connected to it.

To add a text callout to an image:

1. Click the Add Text Callout tool in the toolbar (if necessary, click the drop-down arrow beside the
Add Text tool and select the Add Text Callout tool).

2. Click in the viewport at the location where the arrow will point.

3. Click again in another location (there arrow will end here).

4. Type your text then press Enter.

5. If necessary, you can click and drag the arrow point and/or the text to move it to a more appropriate
location on the image.

To edit the text, double-click on the text, or right-click on the text and select Edit.
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7.3 Measurement Tools
Use the measurement tools to measure features or to view information about a particular region of
interest (ROI) in an image. The measurement tools create annotations on the image with the relevant
information.

Figure 84 Image with measurement annotations

To use a measurement tool, assign the tool to a mouse button and click in the image using that mouse
button. For more information, see 7.1.1 Assigning a Tool to a Mouse Button on page 83.

To stop creating measurement annotations, assign another tool to the mouse button.

Tool Description

Ruler Draws a line on the image and displays its length. For more information, see 7.3.1
Using the Ruler and Protractor Tools on page 89 below.

Protractor Draws an angle and displays its size. For more information, see 7.3.1 Using the
Ruler and Protractor Tools on page 89.

Elliptical
ROI

Draws an ellipse on the image and displays information about the area it contains.
For more information, see 7.3.3 Creating Elliptical and Rectangular ROIs on page
89.

Rectangular
ROI

Draws a rectangle on the image and displays information about the area it
contains. For more information, see 7.3.3 Creating Elliptical and Rectangular ROIs
on page 89.

Polygonal
ROI

Draws a freehand polygon on the image and displays information about the area
it contains. For more information, see 7.3.4 Creating Polygonal ROIs on page 89.

Table 5 Measurement Tools
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7.3.1 Using the Ruler and Protractor Tools
To use the Ruler tool:

1. Assign the tool to a mouse button.

2. Click in the image where youwant to start the measurement.

3. Move the mouse to where youwant to end the measurement and click again to complete the line.
The length of the line (in centimeters) appears in the annotation.

To use the Protractor tool:

1. Assign the tool to a mouse button.

2. Click in the image where youwant to start the first line

3. Move the mouse to where youwant to place the angle vertex and click again to complete the line.

4. Move the mouse to where youwant the second line to end and click again to complete the line. The
size of the angle between the two lines (in degrees) appears in the annotation.

7.3.2 About Regions of Interest (ROIs)
Use the ROI tools to view information about a specific region of an image. When you create an ROI, the
area and the voxel intensity statistics (mean and standard deviation) of the ROI are displayed in the ROI
text label. To hide the text label, right-click on the text and deselect the Show Analysis option. To show
the text again, right-click on the ROI name and select the Show Analysis option.

7.3.3 Creating Elliptical and Rectangular ROIs
To create an elliptical or rectangular ROI:

1. Assign the Elliptical ROI or the Rectangular ROI tool to a mouse button.

2. Click in the image where youwant to start the ROI.

3. Move the mouse until the ROI surrounds the area of interest.

4. Click again to complete the ROI.

7.3.4 Creating Polygonal ROIs
The Polygonal ROI tool creates a polygonal region of interest with any number of sides.

To draw a polygonal ROI:

1. Assign the Polygonal ROI tool to a mouse button.

2. Click on the image to start the first line, thenmove the mouse to where youwant the line to end and
click again.

3. Move the mouse to where youwant the next line to end and click again. Repeat this process to
create the sides of the polygon (each line starts where the last line ended).

4. To complete the polygon, join the end of the last line to the start of the first line, or double-click.
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7.4 Workingwith Annotations

7.4.1 Resizing ROIs and Lines
ROIs and lines are displayed with square "handles" at their edges or endpoints. These are visible when you
mouse over the annotation. To resize an ROI or line, click on a handle and drag it to a new location.

7.4.2 Moving an Annotation
To move an ROI, line, or text annotation, click on the annotation youwant to move and drag it to a new
location.

NOTE: Text labels can be moved independently of the ROI or line they are connected to. Move text labels
as necessary to avoid obscuring details in the image.

7.4.3 Deleting Annotations
To delete a single ROI or annotation, right-click the object and select Delete from the context menu.

To delete all the ROIs and annotations, right-click anywhere in the viewport and select Delete all
Annotations from the context menu.

NOTE: All annotations on all images in the series will be deleted, not just the annotations currently visible.
No confirmation dialog is displayed before the annotations are deleted.

7.5 Synchronization Tools
The synchronization tools link two or more viewports together to assist in cross-referencing images.

Tool Description

Synchronize Stacking Links viewports for synchronized stacking. For more
information, see 7.5.1 Synchronizing Viewports on page 91.

Unlink Studies / Link Studies Unlinks or links viewports that contain series from different
studies. For more information, see 7.5.1 Synchronizing Viewports
on page 91.

Reference Lines Adds reference lines to non-active viewports. For more
information, see 7.5.3 Working with Reference Lines on page 91.

Spatial Locator Adds persistent crosshairs to all viewports. For more
information, see 7.5.4Working with the Spatial Locator on page
92.

Table 6 Synchronization Tools
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7.5.1 Synchronizing Viewports
When synchronized stacking is enabled, viewports are linked so that they stack in tandem. Other image
manipulations, such as panning, zooming, and rotations, are also applied simultaneously to all linked
viewports.

When you click the Synchronized Stacking tool in the toolbar, all viewports containing series in the same
orientation (axial, coronal or sagittal) are linked based on the image DICOM coordinates.

7.5.2 SynchronizationWhen Viewports Contain Series fromDifferent Studies
You can use the Synchronize Stacking tool to link viewports that contain series from different studies. If
the studies were created at different times, however, it is likely that they will have different frames of
reference and the default synchronization will not be adequate. To account for the offset between the
frames of reference, use the Unlink Studies and Link Studies tools to manually adjust the synchronization.

To adjust synchronization between studies:

1. Open a series from each study in a viewport and ensure they are all in the same orientation.

2. Click the Synchronized Stacking tool in the toolbar.

3. Click the Unlink Studies tool in the toolbar.

4. Manually stack through the images in each viewport until they all display the same point of reference.

5. Click the Link Studies tool in the toolbar to re-link the studies.

7.5.3 Workingwith Reference Lines
The Reference Lines tool displays yellow lines on any non-active viewports that are in a different
orientation than the active viewport. These lines correspond to the image in the active viewport. There are
three reference lines: one for each of the first and last images in the active viewport, and one for the
current image in the active viewport.

Figure 85 Reference lines (displayed in right viewport)
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When you stack through the images in the active viewport, the reference line corresponding to the current
location moves in tandem in the non-active viewports.

NOTE: To hide the reference lines corresponding to the first and last images in the active viewport, click
the drop-down arrow beside the Reference Lines tool in the toolbar and deselect the Show First and Last
Reference Lines option.

7.5.4 Workingwith the Spatial Locator
Use the Spatial Locator tool to locate the same point in space in all viewports. When you click the Spatial
Locator tool, a crosshairs icon appears in the viewports. Moving the crosshairs in one viewport updates
the other viewports so that the slice they display intersects the crosshairs coordinate. Location and image
information are also updated in the top right corner of the viewports.

Figure 86 Viewports showing Spatial Locator crosshairs
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8.0 Modus Plan Administration

Modus Plan administration involves tasks such as managing scheduled activities, setting up the
workstation to communicate with other DICOM servers, and configuring default behaviors.

NOTE: Modus Plan is designed to use the default Windows theme. Do not change theWindows theme on
any computer running Modus Plan.

8.1 Working in the Activity Monitor
The Activity Monitor displays information about activities that Modus Plan is performing, or is scheduled
to perform. These activities include:

l Retrieving studies from a remote DICOM server

l Sending studies to a remote DICOM server

l Deleting series or studies from the local database

l Re-indexing the local file store

You can also use the Activity Monitor to start, stop, or change the priority of activities.

To open the Activity Monitor, from the menu bar choose Tools > Activity Monitor.

Figure 87 Activity Monitor tab

1 Workstation information.

2 Links to common administration tasks.

3 Activity list.

4 Use the Activity and Status fields to filter the list of activities by the activity type or status.

5 To search for an activity, enter your search term here. Only those activities that contain the search term (in any
column) are displayed in the activity list. Clear the search field to view all activities.

6 Stop the selected activity.

Page 93 of 124 MAN-0680 Revision B

Synaptive Modus Plan User Manual 8.1  Working in the Activity Monitor



7 Restart the selected activity. You can restart activities that were manually stopped or that failed to complete
normally. Restarted activities start at the beginning of the task, they do not resumewhere they left off when they
were stopped or failed.

8 Delete the selected activities. Activities that are in progress cannot be deleted. Activities that completed normally
are automatically deleted after two hours.

9 Increase the priority of the selected activity to “Stat”. Activities with this priority are processed ahead of activities
with a priority of “High” or “Normal”.

10 The color of the progress bar indicates that status of the activity:
l No color: Pending
l Green: In progress, idle, or complete
l Yellow: Stopped
l Red: Failed

8.2 System Configuration
Use the System Configuration dialog to configure the Modus Plan workstation. To open the System
Configuration dialog, from the menu bar choose Tools > System Configuration.

Figure 88 System Configuration dialog

8.2.1 Local > DICOM Default Servers
Default servers are servers that are selected by default in the plan export options dialog when you export
a plan. Although these servers are selected by default, you can always select additional servers or de-
select a selected server in the plan export options dialog.
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Figure 89 DICOM Default Servers list

In the DICOM Default Servers dialog, select the servers to export a plan to by default.

8.2.2 Local > DICOM Forward
Use the DICOM Forward option to specify the servers where youwant to forward DICOM data. Modus
Plan automatically forwards processed data to the servers you specify whenever a study is pushed to the
workstation.

Figure 90 DICOM Forward options
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Click the Use Default Servers button to automatically select the servers you defined as your default
servers in the DICOM Default Servers settings.

8.2.3 Local > DICOM Send
The DICOM Send options control how Modus Plan behaves when an attempt to send a study to a remote
DICOM server fails.

Figure 91 DICOM Send options

8.2.4 Local > DICOM Server
To communicate with a remote DICOM server, such as a PACS, the Modus Plan workstation must be
configured as a DICOM server itself.
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Figure 92 DICOM Server options

AE Title A unique name to identify this workstation as a DICOM server. It is customary to enter the
AE (Application Entity) Title in uppercase characters.

NOTE: If you change the AE Title for a workstation, youmust update the name on each
DICOM server that is configured to communicate with the workstation.

Port The network port throughwhich this workstation will communicate with other DICOM
servers.

8.2.5 Local > Study Storage
Use the Study Storage options to manage the workstation hard drive space.
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Figure 93 Study Storage options

File Store The location on the hard drive where study images and files are saved when they are
imported into the local database. For information about changing the file store location,
see 8.2.5.1 Changing the File Store Location on page 98.

Disk Usage The amount of disk space currently being used; displayed as percent of the total disk
space available.

Max. Disk
Usage

Adjust the slider to specify the maximum amount of disk space Modus Plan may use.
When this amount is reached, Modus Plan will stop importing or receiving studies.

Automatic
Study Deletion

Select the Delete studies option to allow Modus Plan to automatically delete studies from
the local database and specify when studies should be deleted. Selecting this option can
help to keep the local database size to within the maximum allowed disk space.

NOTE: The local service must be running to apply changes to the automatic study
deletion schedule. If you stopped the local service to change the file store location, start
it again before changing the automatic study deletion schedule.

8.2.5.1 Changing the File Store Location

To change the file store location:

1. Stop the local service (Tools > Service > Stop).

2. In the Study Storage system configuration option, browse to and select the new file store location.

3. If there were studies in the old file store location, copy them to the new file store location.

4. ClickApply then start the local service again (Tools > Service > Start).
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NOTE: If there were studies in the old file store location, or if the new file store location contained studies
before you designated it as the new file store, youmust re-index the file store. For more information, see
8.2.7 Re-indexing the File Store on page 99.

8.2.6 Publishing
The Publishing options configure publishing behavior when adding new content to studies such as study
attachments.

Figure 94 Publishing options

Select the Publish to source server identified in parent study option to publish the new content to the
same server the study was retrieved from. The server must be configured in your Servers list. For more
information see 8.3 Server Configuration on page 100.

8.2.7 Re-indexing the File Store
Under normal circumstances, Modus Plan automatically maintains the index between the file store where
study files are saved and the local database. However in certain circumstances youmay need to manually
re-index the file store. For example:

l You have moved the file store location

l You have upgraded to a new version of Modus Plan

l The study data has become corrupted and it is necessary to rebuild the local database

To re-index the file store, from the menu bar choose Tools > Re-index File Store. The My Studies list is re-
populated as studies are indexed.

Depending on the size of the file store, re-indexing may take a considerable amount of time and you
cannot work in Modus Plan while re-indexing is in progress. If necessary, you can stop the re-index
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operation in the Activity Monitor and restart it at a later time. Studies that were not re-indexed are
restored in the My Studies list in their original state.

NOTE: When you restart the re-index activity, it re-indexes the entire file store; it does not pick up where
it left off when it was stopped.

8.3 Server Configuration
Youmust configure the Modus Plan workstation with information about any other DICOM servers you
want it to communicate with. This includes servers that youwant to receive studies from as well as
servers youwant to publish studies to.

Use the tools in the Servers pane on the Explorer tab to manage your DICOM servers.

Figure 95 Servers pane

1 Servers are listed by name in the Servers pane.

2 You can organize your servers into groups. To add a server to a group, drag it into the group folder.

3 Add a new server. For more information, see 8.3.1 Adding a Server on page 100 below.

4 Create a folder for organizing servers.

5 Edit the selected server or server group.

6 Delete the selected server or server group.

NOTE: You can only delete empty server groups. If the server group contains servers, move the
servers to another group or delete them before deleting the server group.

7 Verify the connectivity of the selected server or server group.

8.3.1 Adding a Server
To add a new DICOM server:

1. In the Servers pane on the Explorer tab, click the Add Server icon.

2. In the Add New Server dialog, enter the server properties (described below).

3. ClickOK.

NOTE: Before a remote DICOM server can communicate with the Modus Planworkstation, it must be
configured with the workstation’s DICOM properties.
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Figure 96 Add New Server dialog

Server Name Enter a name to identify this server.

Host* Enter the server IP address. Youmay also use the server's DNS name if the network is DNS
enabled, however, using the DNS namewill be slower because the computer must resolve
the name. It is recommended that you use the IP address, particularly in an environment
where security is an issue.

Location Enter a description of the server location.

AE Title* The AE Title of the server computer.

NOTE: It is customary to enter the AE Title in capital letters.

Port* Enter the network port to communicate with the server through. The default is 104.

ClearCanvas
Image
Streaming

Select the Enabled option if you are using a ClearCanvas PACS and want to use the
ClearCanvas image streaming functionality. Enter the Header Service port number and the
Image Service port number configured on the PACS.

Study Search Select this option to search the server for related studies such as priors.

* These fields are required to connect to the server.
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8.4 Modus Plan Preferences
Use the Preferences dialog to determine Modus Plan behavior and specify default values for certain
features. To access the Preferences dialog, from the menu bar choose Tools > Preferences.

Figure 97 Preferences dialog (all nodes expanded)

Some preferences pages are grouped under a category in the tree view on the left. Click the plus icon
beside a node to view the pages in that category.

8.4.1 Date Format
The Date Format options determine how Modus Plan displays dates. Choose either the system short or
long date, or select a custom date from the drop-down list.
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Figure 98 Date Format options

8.4.2 Explorer > DICOM
The Explorer > DICOM options determine how the study explorer behaves.

Figure 99 Explorer > DICOM options
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Select Priors
Server(s) on
startup

When this option is selected, Modus Plan will openwith the server (or servers) configured
as your priors servers selected in the study explorer. For more information about
configuring priors servers, see 8.3.1 Adding a Server on page 100.

If the option is not selected, Modus Plan will openwith My Studies selected.

Show numbers
of images in
study

When this option is selected, Modus Plan will display the number of study images (or
instances) in the studies explorer. Deselect this option if your PACS does not return this
information when queried.

Show phonetic
and
ideographic
names

When this option is selected, Modus Plan displays multibyte characters (such as Japanese
characters) in the study explorer when they are present in the DICOM data for a study.

8.4.3 External Applications
Use the External Applications dialog to define other applications youwant to use in conjunction with
Modus Plan, such as other DICOM viewers or report generators. When external applications have been
defined, users can send a study to the external application by right-clicking in the Investigate workspace
and selecting the application to send to.

Figure 100 External Applications options

To add a new external application:

1. ClickAdd New External and select Launch via Command Line (currently, only command line
applications are supported).
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Figure 101 New External dialog

Name Enter a name for the application. This name will appear in the context menuwhen a
user right-clicks in a study and selects Externals.

Command (Full
Path)

Enter or browse to the executable file for the application.

Working
Directory

If necessary, enter the path to the working directory for the application.

Arguments Enter any arguments to pass to the external application. Click the Special Fields link
to see a list of variables you can use with arguments.

Supports
multiple
images

Select this option if the external application supports multiple images. In the Field
separator field, enter the character to use as the field separator.

2. ClickOK.

To edit the properties of an existing external application, select the application and click Edit External.

To remove an external application, select the application and click Remove External.

8.4.4 Layout
Use the Layout options to define the number and configuration of viewports (or image boxes) in the
Investigate workspace. You can configure a different workspace layout for each study modality.
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Figure 102 Layout options

To configure a layout for a modality, select the modality from the list and adjust the number of viewport
(or image box) rows and columns and the number of tile rows and columns to appear in each viewport.

NOTE: The number of tiles you specify here will be applied to all viewports in the layout.

8.4.5 Layout > Hanging Protocols
The Hanging Protocols options control how hanging protocols behave in Modus Plan.

Figure 103 Hanging Protocols options
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Protocol
Application

Select the Automatically apply hanging protocols when a study is opened in the viewer
option to automatically apply a hanging protocol to a study if an applicable protocol
exists.

Specify what should happen if a hanging protocol is not automatically applied:

l Let me lay out display sets myself: Select this option to leave the viewports empty
and allow users to choose the series they want to view.

l Automatically show display sets from the selected study: Select this option to fill
the viewports with the first few series from the study.

If you do not want to make residual layouts available, deselect the Append residual
layouts for unmatched display sets from primary study option.

Residual layouts are hanging protocol layouts created by Modus Plan that contain any
series not included in any other hanging protocol. This is a safety feature to ensure that
users do not miss seeing a series because it wasn’t included in any hanging protocol.

Other Select the Prompt me when closing a study without having viewed all layouts option if
youwant Plan to prompt the user if they close a study without having viewed all the
hanging protocol layouts associated with the study.

Advanced ClickAdvanced to select whether youwant hanging protocols to include the institution
tag when determining applicability.

Figure 104 Advanced Options dialog

8.4.6 Toolbar
Use the Toolbar options to specify the size of the toolbar icons and whether the toolbar should wrap if it
does not fit in the application window. If you do not allow the toolbar to wrap, a drop-down arrow
appears at the end of the toolbar that you can click to access the hidden tools.
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Figure 105 Toolbar options

8.4.7 Tools
The Tools options control the general behavior of basic viewing tools. You can specify different tool
behaviors for different imaging modalities.

NOTE: The Tools options apply to tool behavior in Investigate mode only.

Figure 106 Tools options
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Tool Behavior Modality: Select the modality to configure from the drop-down list.

For each tool select how the behavior should apply:

Per Image: The tool behavior applies to each image individually

Per Display Set: The tool behavior applies to all the images in the series

General Select the Inverted zoom operation option to change the zoom tool behavior so that
dragging up with the mouse zooms out and dragging down zooms in.

8.4.8 Tools > Window/Level
Use theWindow/Level options to manage window and level presets for each imaging modality.

NOTE: The window and level presets you create here are available in both the Investigate and Planmodes.

Figure 107 Window/Level options

1 Select a modality to view its window and level presets.

2 Add a new preset.

3 Edit the selected preset.

4 Delete the selected preset.

To create a window/level preset:

1. From theModality drop-down list, select the modality youwant to create the preset for.

2. Click the Add icon.
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Figure 108 Add Preset dialog

Keystroke Select a keyboard to key to bind the preset to. When you press this key, Modus Plan
will apply the preset to the workspace.

Name Enter a name for the preset.

Window
Width

Enter the window value or use the up and down arrow buttons to adjust the value
by increments of 10.

Window
Center

Enter the level value or use the up and down arrow buttons to adjust the value by
increments of 10.

3. Enter the values for the preset.

4. ClickOK.

NOTE: The window/level settings may cause sulci to appear wider and deeper than they are.

To edit the properties of an existing preset, select the preset and click the Edit icon.

To delete a preset, select the preset and click the Delete icon.
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9.0 Troubleshooting and FAQs

9.1 Troubleshooting

9.1.1 General Problems

Problem Possible Solutions

Part of the screen is missing
or buttons are missing

Make sure that the default screen text size of the computer is set to
100%. Some computers will default to 125%.

Modus Plan, or one of its
subcompoents, crashes

Restart the workstation.

See also 9.1.2 Laptop Problems below.

9.1.2 Laptop Problems

Problem Possible Solutions

Poor resolution Make sure that the resolution is set to 1920 x 1080.

Slow speed Make sure that the computer is not working from the battery.

Make sure the power profile and set it to “High Performance”.

Modus Plan crashes when you
open a study

The laptop may not be configured properly. To adjust the
configuration:

1. Open Nvidia Control Panel.

2. ClickManage 3D Settings.

3. Select the Program Settings tab.

4. Select ClearCanvas from the drop-down list (or add it if it's not in
the list). If you have to browse to locate ClearCanvas, the file is
"ClearCanvas.Desktop.Executable.exe" located in the install
directory.

5. Select High-performance NVIDIA processor from the drop down
list.

6. In the Specify the settings for this program box, scroll down to
Power Management mode and select Prefer maximum
performance.
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9.1.3 Study Import and Data Processing Problems

Problem Possible Solutions

Studies are not getting
through to the database

Make sure that the “Shred Host” service is running in the background.

Make sure the system firewall has been configured to allow
ClearCanvas and the ShredHostService.

Data processing fails with a
negative error message

Make sure that the VC++ 2013 redistributable package is installed. If it is
not, download it from:

http://www.microsoft.com/en-ca/download/details.aspx?id=40784

Youmust be logged in as a system administrator to install the package.

Once the package has been installed, follow the instruction in section
4.1.1.3 on page 43 to manually trigger data processing.

Series selection not as
expected

Make sure that the series selection criteria match the current scanning
protocols and naming conventions.

9.1.4 Problems Specific to Planning Phases

Problem Possible Solutions

Cannot proceed to the next
phase

Some phases have mandatory actions youmust complete before you
can proceed to the next phase.

l Follow any instructions in the dialog that appears when you
attempt to leave the current phase.

l For more information, review the appropriate section in this
reference guide.

In the Segmentation phase,
Modus Plan fails to build a
region

Make sure that the active viewport is the viewport you drew the region
in when you click the Build Region icon in the phase panel.

Trace the region of interest in one viewport only.

Trace the region of interest in one of the 2D viewports.

A trajectory does not appear
correct in the Targets phase.

You can edit trajectories in the Targets phase. Since this phase shows
the standard orthogonal planes, trajectories must be projected onto
them. Sometimes, this results in your engagement point appearing to
be within the brain volume. Refer to the 3D view to confirm the actual
placement.
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Problem Possible Solutions

Unable to use an exported
plan for navigation

By default, Modus Plan exports a report-style plan, which provides
DICOM coordinates that may be entered into your navigation station.
However, it is possible to enable a volumetric export format if your
navigation system requires it. This format produces a derived series,
with the location of your intended target and engagement point
burned directly into the images.

This export format results in greater demands for storage and network
transfer and must be enabled by the Synaptive Medical Customer
Service team.

9.2 Frequently AskedQuestions
Where is Modus Plan installed by default?

C:\Program Files\Synaptive Medical\Modus Plan.

Where is the Modus Plan file store?

C:\ProgramData\Synaptive Medical\filestore.

What are these Synaptive.UsabilityTracking.log files?

Modus Plan records some basic usage information whenever you create a plan. This data includes the
amount of time spent in each phase as well as when you activated different tools. This information is never
connected with a particular Study and is also never transmitted back to Synaptive. When a Customer
Service representative asks for logs, you can choose to include this file, but it is not essential for resolving
most problems.

Where do I find log files?

C:\Program Files\Synaptive Medical\Modus Plan\logs. (To quickly access this folder, in the toolbar click
Help > Show Logs.)

Where did my exported plan go?

Exported plans are placed in the study they were planned from. A copy is stored on the system where you
created the plan. During the export process, you identify a PACS server that youwant the plan pushed to.
This creates a copy of the full study, including the plan, on the target PACS system.
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10.0 Keyboard Shortcuts

Keystroke Function

CTRL + Left Mouse Pan

CTRL + Right Mouse Rotate (only applicable in solid views)

CTRL + Middle Mouse Window/Level

CTRL + Scroll Zoom

CTRL + Z Undo

CTRL + Y Redo

O Toggle text overlays

X Explode/Unexplode

S Assign mouse button to Stack

R Assign mouse button to Rotate (only applicable in solid views)

P Assign mouse button to Pan

W Assign mouse button to Window/Level

Z Assign mouse button to Zoom

L Toggle locator visibility

, Zoom out

. Zoom in

Page Up Stack up

Page Down Stack down

Arrow Keys
(Up/Down/Left/Right)

Window/Level

CTRL + Arrow Keys
(Up/Down/Left/Right)

Pan

F2 Return to default window/level values

Table 7 Keyboard Shortcuts
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11.0 Fiducial Placement Guidelines

If you are using fiducial registration, fiducial markers must be placed prior to image acquisition and remain
affixed to the patient for the duration of image acquisition and during registration. Instruct the patient to
not move during image acquisition and not to remove or alter the fiducial markers prior to, during, or after
the image acquisition.

Use standard MR-compatible adhesive fiducial markers such as IZI Multi-Modality Fiducial Markers. If a
fiducial marker falls off after the image acquisition, leave it off. Do not attempt to re-affix the fiducial
marker.

NOTE: A minimum of five fiducial markers are required to perform fiducial registration using Modus Plan.
It is recommended that you place at least seven fiducial markers on the patient prior to image acquisition
to ensure that at least five are available at the time of registration.

Fiducial markers must be placed on firm skin around the head (for example, mastoid process, zygomatic
arch).

For best results, follow these steps when placing fiducial markers:

1. Shave a small area of hair at the location where the fiducial marker will be placed.

NOTE: If the patient is diaphoretic, applying an adhesive is allowed.

2. Remove the paper backing from the fiducial marker and place the marker on the prepared area.

3. Using an indelible marker, mark the center of each fiducial.

4. Place 7-10 fiducial markers around the head, spread out over as much of the surface of the head as
possible. The minimum supported distance between fiducials is 20 mm.

Distribute the fiducial markers in non-coplanar and asymmetrical locations.

NOTE: To help the surgeon confirm the patient orientation in the images, place two fiducial markers
close to one another on one side of the head.

5. When positioning the patient in a head holder, confirm that the fiducial markers have not shifted
from their original locations.

6. Image the patient using a scan protocol that meets the Synaptive MR scan recommendations (listed
in document MKT-0008).
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12.0 Recommended Hardware and
Software

The following hardware and operating system configuration is recommended for the Modus Plan
software:

l NVIDIA video card with a minimum of 2 GB RAM and DirectX 11.1-compatible

l 2.7 GHz Quad Core CPU

l 32 GB of RAM

l 256 GB SSD with at least 20 GB of free storage space available at all times

l Minimum screen resolution of 1080p (a resolution greater than 1080p may affect performance)

l Keyboard

l Three-buttonmouse is recommended (minimum two-buttonmouse)

l Windows 10 with the latest update package

l Microsoft .NET Framework 4.7.1

l Microsoft PowerShell 4.0

l If Modus Plan will be running on a virtual machine, the VM software must provide AVX hardware
support
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13.0 HIPAA Compliance

Supporting your institution to maintain compliance with the Health Insurance Portability and
Accountability Act (HIPAA) is important to us. Modus Plan provides several features and capabilities which
enable this. The features below apply to Modus Plan when it is running on a system supplied by Synaptive
Medical. For assistance with configuring other systems that will run Modus Plan, contact Synaptive
customer service.

NOTE: Modus Plan is not intended as a long-term store for protected health information (PHI), and
periodic removal of historical information is recommended. The application can be configured to do this
automatically after a defined period of time.

1. Access Control - Unique User Identification

Modus Plan is deployed on theWindows operating system. Users must successfully log into
Windows and thenmust supply their windows user name and password to Modus Plan in order to
directly access ePHI.

2. Access Control - Emergency Access

Modus Plan is not intended as the primary source of ePHI. Emergency access to the Modus Plan
software would require the ability to reset/override or otherwise obtain valid access to the
Windows Operating system.

3. Access Control - Automatic Logoff

Modus Plan is deployed on theWindows operating system. Hospital administrators may use group
(or Domain) policies to establish an automatic logoff that is consistent with their HIPPA policy.

NOTE: Automatic logoff is not configured by default.

4. Access Control - Encryption and Decryption

Modus Plan supports any AES based disk-level encryption.

NOTE: Modus Plan does not ship with encryption enabled by default.

5. Audit Controls

Modus Plan implements a DICOM-compliant audit logging system.

6. Integrity

Modus Plan integrates data review in the procedure workflow. In the first step in the workflow,
Modus Plan displays patient information and study data and requires the user to confirm the data is
correct and appropriate for the intended clinical use. This information, along with standard practices
adopted in the OR to confirm data correctness, facilitates confirmation of data integrity.

7. Authentication

Modus Plan is deployed on theWindows operating system. Users must successfully log into
Windows and thenmust supply their windows user name and password to Modus Plan in order to
directly access ePHI.
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8. Transmission Security

Modus Plan transmits and receives data using the DICOM protocol. This protocol is inherently
insecure and care should be taken to ensure that it is not used across public networks.

9. Protection Against Malware

Modus Plan is installed with a default anti-virus and firewall enabled. Administrators may replace or
configure these components to comply with their security policy.
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14.0 Cybersecurity Considerations

14.1 Secure System Configuration
The features below apply to Modus Plan when it is running on a system supplied by Synaptive Medical. For
assistance with configuring other systems that will run Modus Plan, contact Synaptive customer service.

14.1.1 Anti-Virus
A default anti-virus software application (Windows Defender) is deployed during initial configuration of
your system. It is possible to replace this application with your Institution's approved anti-virus software.

For performance reasons, the following directories and their children should be added as an exception to
any configured anti-virus application:

l C:\ProgramData\Synaptive Medical

l C:\Program Files\Synaptive Medical\Modus Plan

Consult your Synaptive Support representative for further details.

14.1.2 Firewall
The default Windows firewall is deployed and enabled during initial configuration of your system. It is
recommended that you replace this application with your Institution’s approved firewall software. The
following firewall exceptions are required:

l ClearCanvas.Desktop.Executable.exe

l ClearCanvas.Server.ShredHostService.exe

To enable DICOM communication to the Modus Plan system, port 104 must be open for TCP send/receive.

14.2 User Profiles and Permissions

14.2.1 Domain Membership
It is recommended that this system be placed on your institution’s Windows Domain, if one exists. This will
enable centralized management of the system.
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14.2.2 Default User Profiles
l Admin user

The system is deployed with a local administrator account, named “Admin”. This account has
sufficient permissions to enable software configuration, update, and management.

It is recommended that access to this account be restricted to users who are responsible for
maintaining the operation of the system.

l Operator user

The system is deployed with a default local user account, named “Operator”. This account is
configured for general use of the system, and is restricted from software install or update.
Additional accounts may be configured for you during initial installation of the system.

14.2.3 Recommendations Regarding User Accounts and Permissions
l User accounts

It is recommended that a minimum number of user accounts be enabled for the system. If individual
user accounts must be configured, they should be Domain accounts so that account and
authentication settings are consistent for each user.

l Administrator accounts

General users should not be provided with administrator privilege on the Synaptive system.

l Password management

Authentication policy should be adjusted to match your institution's guidelines.

14.3 Device Configuration and Restrictions

14.3.1 Removable Media
Removable media, such as USB and DVD, can be vectors for malicious software. By default, these devices
are accessible to all users. Apply access restrictions to these devices consistent with your institution’s
security policies.

14.3.2 Data Encryption
TheWindows file system can be configured to encrypt data. This may be a useful precaution to protect
patient data stored on the Modus Plan system. Note, however, that the use of encryption can have a
significant adverse effect on the performance of the system. If you enable data encryption tools, it is
recommended that you evaluate their impact on computer and software performance.

14.3.3 Audit Logging
It is recommended that Windows audit logging be configured to capture account “logon events” or audit
“logon attempts”. See https://technet.microsoft.com/en-us/library/cc952128.aspx for details.
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14.3.4 Use of a Trusted Network
Modus Plan uses the industry standard DICOM protocol for transferring image data. In typical
configurations, this protocol does not provide a secure means of data transport. For this reason, Modus
Plan should only be used on trusted networks.

14.4 Windows Update

14.4.1 Minimum Supported Patch Level
Modus Plan supports a minimumWindows patch level which will be provided to IT Operations at the time
of installation or upgrade.

14.4.2 Maximum Supported Patch Level
Modus Plan is periodically validated for compatibility with newWindows updates. A maximum supported
patch level is published on a quarterly basis. The current support level is available through your Synaptive
Service representative.

14.4.3 Update to Supported Patch Level
Modus Plan should be updated to the most current supported patch level as soon as reasonably possible.
These updates can be deployed manually, or through an automated process, such as WSUS.

14.5 System Storage
When not in use, Synaptive systems should be turned off and stored in a secure location.
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15.0 Summary of Performance Test
Results

15.1 DTI Derivative Volume Creation

Data set1 Diffusion Parameter Acceptance Criteria (dB)
Image PSNR Result (dB)

Win 7 Win 10

“Horn Image” FA ≥ 102 147.88 147.88

ADC ≥ 102 153.319 153.319

“Semicircles Image” FA ≥ 102 142.18 142.18

ADC ≥ 102 IDENTICAL* IDENTICAL*

Simple Intersections FA ≥ 102 144.57 144.57

ADC ≥ 102 156.329 156.329

* PSNR is termed IDENTICAL when there is no noise, hence by definition the PSNR value is undefined. This
is the ideal result and represents no difference between the two images.

15.2 Tractography Generation
A third-party software was used to generate tracts for comparison to those generated by Modus Plan
with the same input parameters. Two numbers are shown since the Tract Distance computation contains
two asymmetric components. The first value results from using Modus Plan as the source for the distance
calculation; the second value uses the third-party software as the source. Both directions are not
represented elsewhere because synthetic data is used, and since the tracts are generated by the same
algorithm, large differences should not occur between the two directions.

1 Contact Synaptive Medical for detailed information about synthetic data that was used in this analysis.
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Image Acceptance Criteria (mm)
Mean Tract Distance (mm)

Win 7 Win 10

“Horn Image” ≤ 0.5 0.14 0.14

“Semicircles Image” ≤ 0.5 0.14 0.14

Simple Intersections ≤ 0.5 0.25 0.25

Source Data Acceptance Criteria (mm)
Mean Tract Distance (mm)

Win 7 Win 10

MRI Studio ≤ 1.0 0.27 0.27

“Semicircles Image” ≤ 1.0 0.64 0.64
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